NX 11.0.2 Release Notes
Welcome to NX 11.0.2

January 2017

Dear Customer:

We are proud to introduce NX 11.0.2, the latest release of our NX product development solution. NX 11.0.2 is a major release with significant new functionality in all areas of the product, and we believe that these new and enhanced functions will help you become more productive.

Siemens PLM Software has a clear and consistent strategy: to provide digital product development, simulation, and manufacturing solutions that help you transform your whole product development process. This release delivers enhancements that enable you to increase your levels of productivity while working in a collaborative managed environment.

This release also includes important PR fixes. You can find a list of fixed problem reports for this release in the following locations:

- In the fixed_prs file in the ../docs/fixed_prs directory on your NX software DVD. This file is not copied as part of the install.
- On the Doc Center NX 11 page. To view the fixed PRs, click NX 11.0.2 Fixed Problem Reports.

With the NX 11.0.2 release, we continue to look for innovative ways to deliver solutions that meet your product development, simulation, and manufacturing challenges.

We are confident that our accomplishment of these objectives will enable you to extract the highest value from our solutions. For a complete overview of all enhancements and for additional information about this release, refer to the What's New Guide included with the NX 11.0.2 help.

Sincerely,
The NX Team
## Contents

Welcome to NX 11.0.2 ........................................................................................................... 2

### System Information ................................................................................................................. 1-1
- Customer support ...................................................................................................................... 1-2
- Version up testing ....................................................................................................................... 1-3
- Platforms .................................................................................................................................. 1-3
  - NX central runtime directory ................................................................................................. 1-3
  - System requirements guidelines ............................................................................................. 1-5
  - Operating system requirements .............................................................................................. 1-7
  - Mac OS X Support ................................................................................................................... 1-11
  - Supported hardware and graphics .......................................................................................... 1-15
  - NX Open programs on Linux .................................................................................................. 1-16
  - Linux graphics caveats ............................................................................................................. 1-17
  - Initializing the JVM .................................................................................................................. 1-18
  - NX variables in the ugli_environ.dat file .............................................................................. 1-19
- Browser requirements ............................................................................................................... 1-21
  - Browser and plug-in requirements .......................................................................................... 1-21
  - Browser caveats ...................................................................................................................... 1-23
- Licensing Caveats ..................................................................................................................... 1-24
  - General licensing caveats ....................................................................................................... 1-24
  - Licensing caveats for Windows ............................................................................................... 1-25
  - Licensing caveats for Linux ..................................................................................................... 1-26
  - Licensing caveats for Mac OS X ............................................................................................. 1-27
- Product compatibility - supported version combinations .......................................................... 1-29
- NX compatibility with Spreadsheet .......................................................................................... 1-32
- NX applications unsupported on specific platforms .............................................................. 1-33
- Support for touch enabled devices ............................................................................................ 1-34

### Teamcenter Integration for NX ............................................................................................... 2-1
- Product Notes ............................................................................................................................ 2-2
- Caveats ...................................................................................................................................... 2-3

### Fundamentals .......................................................................................................................... 3-1
- Product Notes ............................................................................................................................ 3-2
- Caveats ...................................................................................................................................... 3-3

### Customer Defaults .................................................................................................................. 4-1
- Customer defaults ...................................................................................................................... 4-2

### CAD ........................................................................................................................................... 5-1
- Modeling ..................................................................................................................................... 5-1
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product Notes</td>
<td>5-1</td>
</tr>
<tr>
<td>Caveats</td>
<td>5-2</td>
</tr>
<tr>
<td>Drafting</td>
<td>5-3</td>
</tr>
<tr>
<td>Product Notes</td>
<td>5-3</td>
</tr>
<tr>
<td>Assemblies</td>
<td>5-3</td>
</tr>
<tr>
<td>Caveats</td>
<td>5-3</td>
</tr>
<tr>
<td>Data Reuse</td>
<td>5-4</td>
</tr>
<tr>
<td>Caveats</td>
<td>5-4</td>
</tr>
<tr>
<td>Sheet Metal</td>
<td>5-4</td>
</tr>
<tr>
<td>Caveats</td>
<td>5-4</td>
</tr>
<tr>
<td>Routing</td>
<td>5-4</td>
</tr>
<tr>
<td>Caveats</td>
<td>5-4</td>
</tr>
<tr>
<td>Documentation Notes</td>
<td>5-6</td>
</tr>
<tr>
<td>Product Notes</td>
<td>5-7</td>
</tr>
<tr>
<td>Ship Structure</td>
<td>5-9</td>
</tr>
<tr>
<td>Caveats</td>
<td>5-9</td>
</tr>
<tr>
<td>Product and Manufacturing Information (PMI)</td>
<td>5-9</td>
</tr>
<tr>
<td>Documentation notes</td>
<td>5-9</td>
</tr>
<tr>
<td>PCB Exchange</td>
<td>5-10</td>
</tr>
<tr>
<td>Caveats</td>
<td>5-10</td>
</tr>
<tr>
<td>CAM</td>
<td>6-1</td>
</tr>
<tr>
<td>Manufacturing Product Notes</td>
<td>6-1</td>
</tr>
<tr>
<td>CAM Early Access program</td>
<td>6-2</td>
</tr>
<tr>
<td>Tool path and template changes</td>
<td>6-3</td>
</tr>
<tr>
<td>General changes</td>
<td>6-5</td>
</tr>
<tr>
<td>Integrated Simulation and Verification (ISV)</td>
<td>6-6</td>
</tr>
<tr>
<td>Turning</td>
<td>6-9</td>
</tr>
<tr>
<td>Hole machining</td>
<td>6-10</td>
</tr>
<tr>
<td>Feature-based Machining (FBM)</td>
<td>6-11</td>
</tr>
<tr>
<td>Manufacturing critical maintenance and retirement notices</td>
<td>6-12</td>
</tr>
<tr>
<td>Manufacturing caveats</td>
<td>6-14</td>
</tr>
<tr>
<td>General caveats</td>
<td>6-14</td>
</tr>
<tr>
<td>Milling caveats</td>
<td>6-16</td>
</tr>
<tr>
<td>Hole machining caveats</td>
<td>6-19</td>
</tr>
<tr>
<td>ISV caveats</td>
<td>6-20</td>
</tr>
<tr>
<td>Post Configurator</td>
<td>6-22</td>
</tr>
<tr>
<td>Feature based machining caveats</td>
<td>6-23</td>
</tr>
<tr>
<td>NX 11.0.2 Manufacturing documentation additions and corrections</td>
<td>6-23</td>
</tr>
<tr>
<td>Simcenter (CAE)</td>
<td>7-1</td>
</tr>
<tr>
<td>New Simcenter application names and product</td>
<td>7-2</td>
</tr>
<tr>
<td>Simcenter supported platforms</td>
<td>7-4</td>
</tr>
<tr>
<td>Pre/Post</td>
<td>7-4</td>
</tr>
<tr>
<td>Caveats</td>
<td>7-4</td>
</tr>
<tr>
<td>Motion</td>
<td>7-8</td>
</tr>
<tr>
<td>Caveats</td>
<td>7-8</td>
</tr>
<tr>
<td>Documentation notes</td>
<td>7-10</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>------</td>
</tr>
<tr>
<td><strong>Design Simulation</strong></td>
<td>8-1</td>
</tr>
<tr>
<td>Caveats</td>
<td>8-2</td>
</tr>
<tr>
<td><strong>Inspection and validation</strong></td>
<td>9-1</td>
</tr>
<tr>
<td>Check-Mate and Requirements Validation</td>
<td>9-1</td>
</tr>
<tr>
<td>Caveats</td>
<td>9-1</td>
</tr>
<tr>
<td>CMM Inspection Programming</td>
<td>9-1</td>
</tr>
<tr>
<td>CMM release notes</td>
<td>9-1</td>
</tr>
<tr>
<td>Caveats</td>
<td>9-2</td>
</tr>
<tr>
<td><strong>Tooling Design</strong></td>
<td>10-1</td>
</tr>
<tr>
<td>Weld Assistant</td>
<td>10-1</td>
</tr>
<tr>
<td>Documentation notes</td>
<td>10-1</td>
</tr>
<tr>
<td><strong>Data translation</strong></td>
<td>11-1</td>
</tr>
<tr>
<td>Product Notes</td>
<td>11-2</td>
</tr>
<tr>
<td>Caveats</td>
<td>11-3</td>
</tr>
<tr>
<td><strong>4th Generation Design</strong></td>
<td>12-1</td>
</tr>
<tr>
<td>Product Notes</td>
<td>12-2</td>
</tr>
<tr>
<td><strong>Mechatronics Concept Designer</strong></td>
<td>13-1</td>
</tr>
<tr>
<td>Product Notes</td>
<td>13-2</td>
</tr>
<tr>
<td><strong>Line Designer</strong></td>
<td>14-1</td>
</tr>
<tr>
<td>Product notes</td>
<td>14-2</td>
</tr>
<tr>
<td>Documentation notes</td>
<td>14-4</td>
</tr>
<tr>
<td>Caveats</td>
<td>14-5</td>
</tr>
<tr>
<td><strong>Programming Tools</strong></td>
<td>15-1</td>
</tr>
</tbody>
</table>

Contents

NX 11.0.2 Release Notes 5
Chapter 1: System Information
Customer support

Customers covered by valid maintenance agreements are eligible to receive telephone and web support from the Global Technical Access Center (GTAC) on issues regarding any current or past release. If you are a customer of one of our partners or resellers, you should contact them first to determine who is your first line support provider. If your first line of support is provided by one of our partners, they will contact us on your behalf if needed to respond to your issue.

To report serious problems against supported releases, please contact your local GTAC support center. You can find your local support center, contact phone numbers and additional information on GTAC support and available services by visiting our GTAC page at http://www.siemens.com/gtac

We will always assist our customers to the best of our ability.
Version up testing

Version up testing helps you to ensure that your existing data will version up smoothly to the latest release of NX. We provide an automated application that checks part features, drawings, and smart model data to make sure that they are compatible with the latest release of NX. You can use this application to test a large collection of data with minimum intervention. You can submit parts with detected problems for further evaluation by Siemens PLM Software by submitting problem reports through normal GTAC processes.

If you are interested in version up testing, refer to the following directories for the appropriate README files and associated utilities.

For feature modeling: ../ugsamples/update_all_features

For drawings: ../ugsamples/TrackDrawingChanges

Platforms

NX central runtime directory

Central runtime directory concept

Starting in NX 11, to help you find executables and libraries, and distinguish them from configuration files more easily, a central runtime directory that contains DLLs, executables, and JAR files is used. The central runtime directory will be updated as NX supports more and different applications.

Scripts that are used to wrap executables have not been moved and they are still in their original kit locations with the configuration files.

NXBIN directory

The central runtime directory, NXBIN, is created on all platforms at the UGII_BASE_DIR\nxbin location during the NX installation. Depending on what was selected to be installed, libraries and executables from different kits are consolidated into the central runtime directory during the install process.

The new NX runtime directory does not contain all binaries and executables. Only the most frequently used files from the following directories have been moved:

- UGII
- UGMANAGER
- STEP203UG
- STEP214UG
- PVTRANS
- MACH

Other files will also be moved over time. However, some applications, such as NX Nastran, will not be moved.
While NXBIN does not contain all of the executables and DLL’s, it does contain a large quantity and is a prime location to search for an executable or library.

**UGII_ROOT_DIR obsoleted**

UGII_ROOT_DIR has historically been used to find the following in the UGII directory:

- Libraries and executables
- Configuration files

With the creation of the central runtime directory, there are two different locations for these files (nxbin and ugii), so the concept of UGII_ROOT_DIR is obsoleted. Use the UGII_BASE_DIR variable instead when you write custom application code and scripts.

While the NX install no longer sets UGII_ROOT_DIR, the definition on the system will remain to support earlier releases. If your code or scripts rely on UGII_ROOT_DIR, modify them to ensure they work in NX 11.

**Teamcenter code and scripts**

To provide backward compatibility with released versions of Teamcenter, all executables called directly by Teamcenter code or scripts are wrapped.

The wrapper executables just correct the settings of the UGII_BASE_DIR, PATH, and LD_LIBRARY_PATH variables that are set by the Teamcenter scripts and code, and then start up the real executable from the NXBIN directory. This enables support for the new runtime concept, while allowing NX to run with existing versions of Teamcenter.

These new wrapper executables must remain in the ugii and ugmanager directories since that is where Teamcenter code expects to find them. Two processes are shown for executables invoked from the ugii and ugmanager directories.

Executables are still in the UGII, UGMANAGER, STEP203UG, STEP214UG, and PVTRANS kits. Teamcenter code migration to the new central runtime directory structure is scheduled in a future Teamcenter release.
System requirements guidelines

Defining the minimum system requirements is difficult because key requirements, most notably memory, can vary dramatically from user to user. The following are general guidelines that you should consider before purchasing a system.

Processor performance

Although raw processor speed has a major impact on system performance, other factors also contribute to overall performance; for example, the type of disk drive (SCSI, ATA, or Serial ATA), disk speed, memory speed, graphics adapter, and bus speeds. The general rule is that "the faster the processor, the better the performance is," but this only applies when comparing like architectures. For example, it is difficult to arrive at performance expectations for an Intel processor when compared to an AMD processor just by looking at their respective processor speeds. There is also a general trend today to de-emphasize processor speeds and move to multi-core processors, which actually can have lower processor speeds.

SMP

Symmetric Multiprocessing (SMP) is supported in NX mostly via Parasolid, although a small number of NX capabilities have some threading. In general, it is not possible to quote a figure for the general performance improvement achieved by using SMP, since this improvement depends on the nature of the operations you are performing. You need to evaluate your actual performance gains using your own models. Functional areas that are SMP enabled in Parasolid include:

- Validity checking
- Boolean operations
- Wireframe
- Rendering
- Hidden line rendering
- Closest approach
- Faceting
- Mass properties

SMP is enabled by default with the variable UGII_SMP_ENABLE, which is located in the ugi_env_ug.dat file.

Multi-Core

Multi-core processors are similar to SMP because there are two or more actual processor cores but they are delivered in single processor packages. Siemens PLM Software has found that multi-core performance characteristics are similar to SMP. The one advantage of multi-core processors over SMP is that this technology has proliferated much faster than SMP and is now common in workstations, servers, and laptops.
Multi-core technology is complex and, depending on the configuration, can actually have a negative impact on performance. This is due to the potential conflict of multiple cores sharing system resources, such as cache, memory, and bus bandwidth, as well the need for the system to manage and control an increasing number of cores. Increasing the number of cores does not always translate into better performance. Although additional cores can improve NX performance, processor speed is still a vital measurement of NX performance.

Many systems enable you to turn off cores via the bios, which can enable you to compare performance with a different number of cores that are active. Some users may find that turning off some cores will actually improve performance. One micro-architecture (Intel) even does this automatically, shutting down unused cores and increasing the clock speed of the others.

The hardware vendors continue to improve their processor micro-architectures to better address the limitations of older multi-core technologies. New subsystems better integrate memory and other peripherals directly to the processors, resulting in major performance improvements. Buses are being eliminated, cores are better managed, and channel speeds continue to improve.

In summary:

- Turn SMP on only if you have an SMP system. Having it on in a single-processor system incurs a slight overhead.

- Turn SMP on if you have a multi-core system.

- Never assume that by simply adding more cores you will see better performance. Always test first.

**Memory**

For Windows 7, the minimum amount of memory is 4 GB, but we recommend 8 GB or 16 GB of memory as a starting point. Large models and assemblies or running multiple processes concurrently could boost the required memory for adequate performance.

**Graphics adapters**

All the NX certified systems contain graphics adapters that meet all Siemens PLM Software requirements and are fully supported by our hardware partners. The graphics adapters supported are carefully selected by working with our OEM partners as well as our graphics vendor partners. We do not recommend low-end, consumer, or game cards, since these graphics devices are developed for the DirectX market and are not well supported under OpenGL. Because a majority of platform/hardware problems are graphics related, it is critical that all the graphics adapters that NX supports are designed for OpenGL and have the highest level of support from our hardware vendors. We highly recommend that you only use supported graphics adapters and Siemens PLM Software certified drivers.

If you are running Microsoft Windows 7 you will require graphics adapters with more on-board memory, especially when AERO (the enhanced 3D feature) is turned on. The minimum recommended graphics on-board memory is 256 MB, and although graphics adapters with less memory will work, the performance may not be adequate, even with AERO turned off. If you have high-end graphics requirements, you will need to consider graphics adapters with 512 MB or higher on-board memory.

For the latest information on certified graphics cards and driver versions, please visit the Customer Support (GTAC) Web site.
Multiple monitors

Siemens PLM Software supports multi-monitors but with limitations. These limitations were necessary due to the large number of possible configurations. Other combinations may work, but these conditions are tested and supported by Siemens PLM Software. These guidelines could be extended or relaxed in the future.

The following is a summary of findings for the support of multiple monitors.

- NX 6.0.1 or higher - no older releases are supported.
- Two monitors only.
- LCD monitors only
- Run with native resolution and aspect ratio.
- Laptops are tested without docking stations or port replicators (direct connection only).
- Horizontal Scan mode (not Vertical) and only with identical monitors.
- Dual View (Nvidia) or Extended View (ATI) modes, but the user must have the display window entirely in either the primary or secondary monitor.

You do not have to comply with the configurations mentioned above, but Siemens must be able to duplicate the problem on the configurations in our labs before being able to investigate your issues.

Operating system requirements

Minimum Operating Systems

The following operating systems are certified and the minimum recommended for NX 11.0.2. Newer versions and service packs are certified as they are released.

<table>
<thead>
<tr>
<th>O.S.</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Windows (64-bit)</td>
<td>Microsoft Windows 7 Pro and Enterprise editions</td>
</tr>
<tr>
<td>Linux (64-bit)</td>
<td>SuSE Linux Enterprise Server/Desktop 12</td>
</tr>
<tr>
<td></td>
<td>Red Hat Enterprise Linux Server/Desktop 7</td>
</tr>
<tr>
<td>Mac OS X</td>
<td>Version 10.10.3</td>
</tr>
</tbody>
</table>

Note

Simcenter does not support the Mac OS X.
Windows 7 and 8.1

NX 12 will be the last release to support Windows 7 and Windows 8.1. Windows 10 will be the minimum supported release for subsequent releases of NX. The supported versions of Windows 10 are the Professional and Enterprise editions utilizing either the Current Branch for Business (CBB) or Long Term Service Branch (LTSB) update branch. The Current Branch (CB) update option is not supported.

Windows XP and Vista

Windows XP support from Microsoft has ended and Vista was rarely deployed so these two versions of Windows are not supported by NX 11. Siemens PLM Software has not performed testing on these versions and cannot resolve any issues related to NX 11 running on these operating systems. If NX 11 is deployed on these versions of Windows, any issues will have to be replicated on Windows 7 before filing an incident report with GTAC.

Windows 10

Windows 10 is certified for NX 10.0.3 and later versions including NX 11. Any caveats or special instructions are provided in the SFB announcing support.

Linux Distributions

NX is developed using Linux standards and accepted Linux development conventions. Quality assurance testing is performed on the two versions of Linux listed in the table above. Siemens PLM Software cannot guarantee operation, performance, compatibility, or support on any other distributions.

The following is a list of information about the NX 11 development environment (for reference only):

<table>
<thead>
<tr>
<th>Component</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Kernel</td>
<td>kernel3.10.0-123el7.x86_64</td>
</tr>
<tr>
<td>X Windows</td>
<td>libX11-devel-1.6.0-2.1</td>
</tr>
<tr>
<td>Motif</td>
<td>motif-devel-2.3.4-7</td>
</tr>
<tr>
<td>Open GL</td>
<td>mesa-libGL-devel-9.2.5-5.20131218</td>
</tr>
<tr>
<td></td>
<td>mesa-libGLU-devel-9.0.0-4</td>
</tr>
<tr>
<td>C, C++ Compiler</td>
<td>gcc 4.8.2</td>
</tr>
<tr>
<td>Java Development version</td>
<td>1.8.0</td>
</tr>
</tbody>
</table>

Considerations and caveats

End of support for NX 32-bit

The memory addressing limitations of 32-bit processing and the widespread deployment of 64-bit systems has pushed OS providers, hardware vendors, and application developers to migrate their products to the 64-bit version. As a result, NX 11.0.2 is available as 64-bit only and customers will need to migrate to the 64-bit version, if they have not already done so.

Today, 64-bit processors are used in desktops, laptops, and workstations whether for consumers, gamers, or enterprise environments. The server version of Windows 7 is already 64-bit with no available 32-bit version. Siemens PLM Software supported 64-bit starting with UNIX and supported only 64-bit on Linux and Mac OS.
Microsoft Windows 8 and 8.1

Windows 8 and 8.1 were certified with NX 8.5.2 and are supported for that version and all subsequent versions of NX including NX 11.

Microsoft Windows 7

NX supports Windows 7 64-bit only; NX does not support Windows 7 32-bit. NX supports the Windows 7 Professional and Enterprise editions only.

Windows 7 requires considerably more resources (memory, disk, and so on.) than Windows XP, so it may be necessary to increase memory or disk, upgrade your graphics adapter, or even replace your workstation, to achieve the same performance available under Windows XP.

Note

Siemens PLM Software recommends a minimum of 4 GB of memory and a graphics adapter with at least 256 MB of on-board memory, but 512 MB or higher for those with large or complex models.

Besides the expected increases caused by this new enhanced operating system, Windows 7 has some special features that can increase memory usage quickly. The 3D desktop, user interface, and graphics capabilities of Windows 7 differ dramatically from those of Windows XP (you must think of this as a new OS and not a WXP upgrade) and can consume considerable memory resources. In addition, although Windows 7 supports OpenGL similar to previous versions, other changes in Windows have impacted the way graphics vendors use system resources (like memory). For Windows 7, the recommendation is to either increase on-board graphics adapter memory, or increase system addressable memory, or both.

Visit the Customer Support (GTAC) Web site for details of supported hardware configurations as well as for the latest graphics drivers.

Linux Requirements

NX supports SuSE Linux and Red Hat Linux, both 64-bit only. The minimum supported version of SuSE Enterprise (Desktop/Server) is 12 and Red Hat Enterprise (Desktop/Server) is 7.0. Newer versions will be supported via certification.

Note

Ensure that X11 and the Motif libraries are installed.

Visit the Customer Support (GTAC) Web site for details of supported hardware configurations as well as for the latest graphics drivers.

Java Runtime Environment

Starting in NX 8.5, the Java Runtime Environment (JRE) is no longer shipped with NX. NX requires JRE 8. To install the JRE, visit the Java download site at http://java.com/en/download/index.jsp

Java is used for the following products:
Chapter 1: System Information

- NX Relations Browser
- Product Template Studio
- Manufacturing – Process Studio Author
- Command line version of the following translators:
  - CATIA V4
  - CATIA V5
  - Dxfdwg
  - IGES
  - NX Pro E
  - Step AP203
  - Step AP214
- Knowledge Fusion ICE
- Online Help

**Note**

NX 9.x and earlier versions contain a different Help Search that requires the latest version of the Java plugin installed as an Add On to the browser. NX 10 and later versions do not require the Java plugin for the Help Search.

- Quality Dashboard
- Validation Rule Editor
- Batch Mesher
- Customer written NX Open Java programs
- NX Response Simulation Function Tools

**Java requirements for NX Open**

NX Open for Java is designed to be used with Java version 1.8.0 or higher.

**Post Processing of Abaqus ODB format results**

In the NX 11.0.2 release, NX uses Abaqus version 6.12 libraries to process ODB results files. For NX to use these libraries, you must first install Visual C++ 2008 X64 Runtime – v9.0.30729.4967.
Note
If you have Abaqus version 6.12 installed on your system, the required Visual C++ runtime should already be installed.

You can download this runtime from the Simulia customer support website:
http://www.3ds.com/products-services/simulia/support/

For more information on the system requirements for ODB version 6.12 files, see:
http://www.3ds.com/support/certified-hardware/simulia-system-information/abaqus-612/system-requirements-for-abaqus-612-products

Running Samcef in parallel

On Windows, when you run parallel computations with the built-in Samcef solver, Python 2.7 is required. In NX 11, that version of Python is not present. Install Python 2.7 on your disk and ensure that the Python directory is named Python27 (default name) and is included on your PATH variable.

You can download the software from the Python website: https://www.python.org/downloads/

Note
The Python requirement does not apply if you have Samcef installed separately from NX.

Configuration files

Starting with NX 11.0.2, the NX configuration files on Windows are written to
C:users\<name>\AppData\Local\Siemens.

Installing the .NET Framework

The NXOpen for .NET API is a Windows-specific project that leverages the Microsoft .NET Framework component. Before you can execute a custom .NET application, you must install the .NET Framework 4.5. In addition, to replay a .NET journal, the .NET Framework 4.5 must be installed.

To download the .NET Framework 4.5, use the links on this page: Microsoft .NET Framework 4.5 (Web Installer).

Note
If you have installed Visual Studio 2012 SP1, then you have .NET Framework 4.5 installed by default.

Mac OS X Support

Hardware and installation requirements

Hardware and operating system requirements

The release of NX 11.0.2 on Mac OS X supports Apple Mac 64-bit Intel based systems. These include the MacBook Pro, iMac and Mac Pro systems. All available graphics subsystems are supported.
The minimum version of Mac OS X required to run NX 11.0.2 is version 10.10.3. Later versions of Mac OS X are also supported, but there may be caveats.

Installation of NX on Mac OS X is supported only on an HFS+ file system. However, NX part files and other data files may be stored and retrieved from an NFS file system.

**X11 requirements**

NX 11.0.2 on Mac OS X utilizes X11 to support its graphical user interface. Xquartz 2.7.8 is required on OS X 10.11 "El Capitan." You will be prompted to install Xquartz when attempting to run any X11 application for the first time and guided through the installation by those prompts. Check for Xquartz updates from the X11→Check for X11 Updates... dialog box.

You can download Xquartz at [http://www.xquartz.org/](http://www.xquartz.org/)

The X11 application must be running while using NX. The X11 application is started when NX or any other X-based application is invoked.

**Installation**

Installation must be performed from an account with administrator privileges. To install, double-click on the `ug_install` script.

**Product notes**

**Mouse focus policies**

The X11 mouse focus policy specifies how the mouse advises X11 on which window is active and can receive keystrokes. The **Click-through Inactive Windows** and **Focus Follows Mouse** operations are often preferred to the X11 defaults.

In the X11 bundled with Lion, the mouse focus policies are set by choosing `X11→Preferences, Windows` tab. The **Windows** tab contains the following options:

- **Click-through Inactive Windows**
- **Focus Follows Mouse**
- **Focus On New Windows**

You must restart X11 for a change to take effect. Note that the setting applies only to the user's own preferences, not to the system wide preferences. Refer to the `quartz-wm man` page for details.

**Pasteboard/Clipboard Setup**

The X11 Pasteboard policy defines how the Mac OS Pasteboard communicates with the X11 CLIPBOARD. To ensure proper clipboard copy/paste behavior in NX, syncing between the Mac OS Pasteboard and X11 CLIPBOARD should be disabled.

In the X11 bundled with Lion, the Pasteboard policies are set by choosing `X11→Preferences, Pasteboard` tab. Uncheck the **Enable syncing** option.

Note that the setting applies only to the user’s own preferences, not to the system wide preferences. Refer to the `quartz-wm man` page for details.
3D Input Devices

Support for 3Dconnexion input devices is available for NX on Mac OS X through the use of drivers and software available directly from 3Dconnexion. Use the following link to download the software and get installation information.

http://www.3dconnexion.com/service/drivers.html

Plotting

MAC OS X printing systems handle PDF files in native mode. NX Plotting takes advantage of this by creating a PDF file which it hands off to a Macintosh application that handles the printing task. Because these native tools can interface with the printing system, the usual SDI plotting software used with other platforms is not used on MAC OS X.

Teamcenter Integration support for Mac OS X

Teamcenter Integration (TCIN) is supported on the Mac platform when you run in a four-tier environment. The operation and functionality of Teamcenter Integration on the Mac platform is the same as on other platforms.

Note

The Teamcenter two-tier environment is not supported.

The Mac client setup in a four-tier Teamcenter environment is similar to the setup for Linux. However, you have to install the Mac client as a TCCS installation instead of an FMS installation. Typically, the TCCS install is done as part of the RAC TC install, but since the Teamcenter RAC install does not support the Mac platform, the TCCS standalone installer needs to be used. This installer is provided on the Teamcenter Mac DVD or Mac install download. For install and setup information, see the Teamcenter installation documentation.

After installation is complete, you can create a script to setup TCIN for use before launching NX. The following is a sample script:

Note

• The values and paths used here are for example only. Use the values and paths that are applicable for your site.

• The line:

defaults write com.siemens.plm.nx11 PIM Yes

sets the -pim option to Yes. You can set this back to No to run native NX.

• You do not set the user name (-u) and password (-p) options in the script. You enter these in the dialog box that is displayed when you run NX.

Sample script:

defaults write com.siemens.plm.nx11 FMS_HOME /home/UGS/Teamcenter/Tc11/tccs
Caveats

Mac OS X 10.10

If you are using Mac OS X version 10.10 (Yosemite), the minimum supported version for NX 11.0.2 is version 10.10.3. Apple’s release of Yosemite (Mac OS X 10.10) does not include the X11 libraries required by NX.

Xquartz 2.7.7 is required. You will be prompted to install Xquartz when attempting to run any X11 application for the first time and guided through the installation by those prompts. Check for Xquartz updates from the X11→Check for X11 Updates.... dialog box.

CAE

NX 11.0.2 on Mac OS X does not support any Simcenter (CAE) functionality. Simcenter modules and specialized NX functions that depend on Simcenter are not supported.

Plotting

Plotting of high quality images using the View→Visualization→High Quality Image command does not work.

Relations Browser

The relations browser is not supported. When you choose Assemblies→WAVE→Relations Browser, the command does not work.

Spreadsheet support

NX 11.0.2 on Mac OS X does not support the use of any spreadsheet.

Enabling the Alt key

When you use NX, the Alt key can be very handy. The Mac OS does not automatically enable the Alt key for use with NX. You have to update the X server's keyboard mapping.

Redefine the key on the keyboard

To enable the Alt key, you need to update the keyboard mapping to redefine the key labeled alt/option. Enter the following command in a Terminal window:

```defaults write org.x.X11 option_sends_alt -boolean true```

The alt/option key now sends Alt_L and Alt_R instead of Mode_switch.
Supported hardware and graphics

The list of currently supported hardware and graphics cards can be found on the GTAC support page Customer Support (GTAC) Web site at Hardware and Software Certification→Hardware (Graphics Card) Certifications. This opens a spreadsheet that has tabs for supported systems and graphics.
NX Open programs on Linux

If you try to link an external NX Open C++ program using the ufmenu and uflink scripts with NX 11 on SLES 12, Linux may fail with an error message such as:

```
/usr/x86_64-suse-linux/bin/ld: cannot find -lelf
/usr/x86_64-suse-linux/bin/ld: cannot find -lXm
```

For NX to properly build an NX Open program, you must have the correct RPM kits installed.

For NX 11 and SUSE 12, the following packages are required:

```
libXm4-2.3.4-4.15.x86_64.rpm
motif-devel-2.3.4-4.15.x86_64.rpm
elfutils-0.158-3.200.x86_64.rpm
libelf1-0.158-3.200.x86_64.rpm
libelf-devel-0.158-3.200.x86_64.rpm
```

For NX 11 and RedHat 7, the following packages are required:

```
motif-2.3.4-7.el7.x86_64.rpm
motif-devel-2.3.4-7.el7.x86_64.rpm
elfutils-libelf-0.158-3.el7.x86_64.rpm
elfutils-libelf-devel-0.158-3.el7.x86_64.rpm
elfutils-devel-0.158-3.el7.x86_64.rpm
elfutils-libs-0.158-3.el7.x86_64.rpm
```

Note

For SUSE, the `devel` packages are available from the optional SLE 12 SDK DVD/ISO.
Linux graphics caveats

Some applications experience a severe X server crash with Red Hat 7 (and later) and SuSE 12. The crash of the server causes the user to exit the login session. When this occurs, the user must login again. This problem has only been seen on nVidia graphics boards. If you are using an older driver, the first recommendation is to try the latest graphics driver. If this problem is observed in other applications, the following workaround can be applied.

Note

Use this workaround only if you experience the problem, as it can cause a performance slowdown. To work around this problem, modify /etc/X11/xorg.conf and add the following line to the Device section for nVidia after the Driver line.

Option "UseCompositeWrapper" "true"

Thus, after the change, the device entry in xorg.conf might look like:

Section "Device"
  Identifier      "Videocard0"
  Driver         "nvidia"
  Option         "UseCompositeWrapper" "true"
EndSection

You must login as root in order to make this change. It is prudent to make a backup copy of /etc/X11/xorg.conf before making this change. Each time the nVidia driver (the same or a newer version) is installed, you need to take the above steps to ensure the Option line is included. In order for the change to take effect, you must restart the X server by either rebooting or pressing Ctrl+Alt+Backspace (if you are in a live X session).

Note

With some AMD configurations on Red Hat and SuSE, a different problem has been observed whose similarity with the problem seen with the nVidia configuration may cause you to believe it is the same problem. This problem causes NX and many X applications to fail with a segmentation violation or a memory fault at the start. However, this problem is likely due to the AMD graphics driver not being configured correctly. The simple solution to this problem is to do the following:

1. Login as root
2. Make a backup copy of /etc/X11/xorg.conf.
3. Remove /etc/X11/xorg.conf.
4. Regenerate a new xorg.conf by running the command:
   aticonfig --initial
5. Restart the X server.
Initializing the JVM

In some cases, NX is not able to create the Java Virtual Machine (JVM) properly on Windows. The root cause in these scenarios is insufficient memory to start the JVM. In most cases of insufficient memory Java is able to report back an error code indicating this problem. However, in some cases Java reports a generic error message that NX then displays. The typical error message is:

Can’t initialize the Java Virtual Machine (JVM)

When running a Java application, such as the Wave Browser or Interactive Class Editor, NX may give an unexpected error due to this problem.

Starting in NX 8, if NX detects that there is not enough memory available for the JVM, an error message is given and information is provided in the syslog. The following is an example of the syslog information:

The JVM could not be created due to not enough memory.
The Java heap size must be contiguous and the largest contiguous block available is outputted below.
Windows largest block free
=================================
Maximum block 267Mb
=================================
Please note, this number is to be used as suggestion for setting the heap size. It is unlikely that you will be able to utilize the full amount.
If you need a heap size larger than what is possible you can try to use the /3GB switch or its equivalent, if available for the Operating System you are on. Otherwise your other option is to use Remoting. Please consult the NX Open Programmer's Guide for more information on this topic.

Reset the size of the Java heap

To remedy this problem, you can reset the size of the Java heap that NX uses. Choose File→Execute→Override Java Parameters to open the dialog box and set UGII_JVM_OPTIONS to the size of the Java heap. You can experiment with the size of heap that you need, but if the JVM is already started then you cannot change the UGII_JVM_OPTIONS setting.

It is recommended that you use both the \-Xmx and \-Xms options together. Both of these are needed as Java may determine default values for the heap size that are not possible with the machine’s current memory load. For example:

UGII_JVM_OPTIONS=\-Xmx=50M \-Xms=50M

When trying to determine the size of the heap, keep in mind that if the heap size is too small, a Java program you are trying to run may not run. This could be due to the amount of memory available on the machine, or due to multiple Java processes running. This can be the case with the Wave Browser where there is a client and server process.

Once you find a value that works, you can modify the UGII_JVM_OPTIONS value in the ugi_env.dat file so you don’t have to reset it in the NX Open Java Parameters dialog box each time you start an NX session.
NX variables in the ugii_env.dat file

Standard and modified environment variables

The ugii_env_ug.dat file contains the standard environment variables for NX. You can override these variables with the ugii_env.dat file. This file is essentially empty when delivered. You can define new values for the environment variables in this file and they take precedence over the values defined in the ugii_env_ug.dat file.

The ugii_env.dat file should be used to modify any standard NX environment variables or add new ones.

Both the ugii_env_ug.dat and ugii_env.dat files are located at <UGII_BASE_DIR>/ugi.

Note
You can make all, some, or none of the changes to the variables in the ugii_env_ug.dat file. However, it is recommended that you use the ugii_env.dat file to define all of the values in use at your site.

Using the ugii_env.dat file

The following apply when using the ugii_env.dat file:

• Define the variables before the #include statement.

• The first variable defined is used. If you have the variable defined twice in the file, only the first one is used.

Note
This also applies to the ugii_env_ug.dat file.

• You cannot have spaces in the variable names.

Designate a single ugii_env.dat file for all users

You can place the ugii_env.dat file in a central location for all users to access.

For each user, set the environment variable UGII_ENV_FILE to the location of the file. For example:

UGII_ENV_FILE=G:\common\version_env_vars.corp_standards

Note
The file can have any name but must be a fully qualified path.

Statements you can use in the ugii_env.dat file

The statements that you can use in the ugii_env.dat file are shown below with examples:

• #if/#else/#endif
Used to check for specific conditions and then to define variables based on those conditions. Conditions that can be checked are:

- **FILE** - Check for the existence of a file
  
  ```
  #if FILE ${UGII_BASE_DIR}\UGII\html_files\start_${UGII_LANG}.html
  UGII_CAST_HOME=${UGII_BASE_DIR}\UGII\html_files\start_${UGII_LANG}.html
  #else
  UGII_CAST_HOME=${UGII_BASE_DIR}\UGII\html_files\start_english.html
  #endif
  ```

- **platform** - Check for a specific platform. Possible values:
  - x64wnt
  - Lnx64
  - macOS

  ```
  #if Lnx64
  UGII_CAM_THREAD_MILL=${UGII_CAM_THREAD_MILL_DIR}thrm.so
  #endif
  ```

- **$variable = “value”** - Check for a specific value for a previously defined environment variable
  
  ```
  #if $UGII_LANG = "simpl_chinese"
  UGII_COUNTRY=prc
  UGII_COUNTRY_TEMPLATES=${UGII_BASE_DIR}\localization\${UGII_COUNTRY}\simpl_chinese
  #endif
  ```

- **$variable != “value”** - Check for a previously defined environment variable that does not have the specified value.
  
  ```
  #if ${UGII_PACKAGE_DIRECTORY} != ""
  #if FILE ${UGII_PACKAGE_DIRECTORY}\ugii_package_env.dat
  #include ${UGII_PACKAGE_DIRECTORY}\ugii_package_env.dat
  #endif
  #endif
  ```

- **#include**

  Used to include a specified environment file at the current location
  
  ```
  #include ${UGII_PACKAGE_DIRECTORY}\ugii_package_env.dat
  ```

### Enabling context sensitive help in local languages for customer defaults and KF

When using localized language versions of the NX Help, to get context sensitive help to work for Customer Defaults or Knowledge Fusion you need to edit the following two environment variables to point to the localized help:

- **UGII_CSHELP_DEFAULTS_DOCS**
- **UGII_CSHELP_FUSION_DOCS**

For example, to enable context sensitive help for Japanese Customer Defaults help you would set:

```
UGII_CSHELP_DEFAULTS_DOCS=${UGII_UGDOC_BASE}/data_services/resources/nx/${UGII_MAJOR_VERSION}/nx_help/ja_JP/graphics/fileLibrary/nx/cust_defaults
```
Browser requirements

Browser and plug-in requirements

The NX suite of documentation (Help, What's new Guide, and Release Notes) is provided in an HTML format that is displayed in your local Web browser.

The documentation requires a web server. You can install the Siemens PLM Documentation Server, which sets up a local web server on each workstation, or install the documentation into an existing company-wide server.

The latest versions of web browsers are recommended to comply with the latest browser security updates.

Windows browser support

• Internet Explorer
• Microsoft Edge
• Mozilla Firefox
• Google Chrome

Linux browser support

• Mozilla Firefox

If you have other Mozilla web browsers installed on your system, make sure either your default browser is set to the correct Firefox version, or the UGII_HTML_BROWSER environment variable in your ugui_env.dat file is set to the supported Firefox version.

Mac OS X browser support

• Safari
• Google Chrome

Downloading browsers

These browsers are free and can be downloaded from the following Web sites:

  Internet Explorer — http://www.microsoft.com

  Firefox — http://www.mozilla.org

  Safari — http://www.apple.com
Windows .chm files

Some parts of the Help are delivered in Microsoft Compiled Help format (.chm). Windows security enhancements prohibit opening .chm Help files across a network, so you must install those files on your computer. If you install .chm Help files on a server, you cannot read the Help across the network.

Flash required for videos

To watch videos and simulations, you must have the Adobe Flash Player installed as a plug-in to your browser. You can download the Flash Player (free) at the Adobe Flash Player site.

Adobe Acrobat Reader

Some portions of the Help may be delivered as PDF, which requires the Adobe Acrobat Reader. You can download the free reader from http://get.adobe.com/reader/.
Browser caveats

Browser caveats for Internet Explorer

IE9 compatibility view. The HTML Help is fully supported when launched with the http:// protocol or the file:// protocol. However, if you are viewing an older version of the Help from a local installation, such as D: //, you may need to enable the Compatibility View. In IE 9, perform the following:


2. In the Compatibility View Settings dialog box, select Display all websites in Compatibility View.

Browser caveats for Firefox

- Mozilla recommends that you upgrade to the latest version of Firefox due to security issues surrounding Java. They do not recommend using older versions of Firefox. For more information, see http://support.mozilla.org/en-US/kb/latest-firefox-issues.

- The default behavior in Firefox 3.0.5 is for new pages to be opened in a new tab. This affects the behavior of the global search since new links will open in a tab instead of a new window. You can configure Firefox to open a new window instead of a new tab by selecting Tools→Options→Tabs.

- Typically, you install and launch the Help from the http:// protocol which is fully supported. However, if you want to launch from a UNC path (file://), Firefox has a default security setting that prevents the Help from launching correctly. To enable this, you need to change the value of the security.fileuri.strict_origin_policy preference:

  1. In the address bar, type about:config.

  2. In the Filter field, type security.fileuri. If the value of the security.fileuri.strict_origin_policy preference is set to TRUE, set the value to FALSE. Double-click on the value to toggle it.

  3. Restart the browser.

- If you are trying to open a .chm file that you have accessed from a web server (not from a local install), you may not be able to open the file as it is blocked. To unblock, right-click on the file and choose Properties, then select the unblock option.

Browser caveats for Chrome

Typically, you install and launch the Help from the http:// protocol which is fully supported. However, if you installed with the file:// protocol, you have to run Help from the command line. To fix this, see http://code.google.com/p/chromium/issues/detail?id=39767.
Licensing Caveats

General licensing caveats

License files and license server

The following are applicable to license files and the license server:

- Merging of license files is not supported.

**Example**

You can not merge a pre-TC 2007 MP3 or pre-NX 5 license file, which uses the `uglmd` license daemon, with a TC 2007 MP3, NX 5, or NX 6 license file, which uses the `ugs1md` daemon.

NX 11.0.2 requires and tests for the latest version of the `ugs1md` vendor daemon. This vendor daemon is supplied with NX 11.0.2 and must be installed and initiated prior to starting NX 11.0.2. If an older daemon is utilized, a generic NX License Error dialog box is displayed during start-up. In addition, the syslog will contain an error message that the daemon version is older than the client.

- The SPLM License server install requires that Java 1.8.0_45 is installed on the system.

NX Borrowing is version specific

NX license borrowing is version specific due to dependencies within the third party licensing software used by Siemens PLM Software. To ensure that NX works on a borrowed license, you should always utilize the borrow tool supplied with that NX version. For example, a license borrowed using the NX 11 borrowing tool will work for NX 11 but cannot be used to run NX 10. In addition, you cannot borrow licenses for two NX versions simultaneously on the same workstation.

Licensing Guides

Refer to the NX 11 software DVD for the most recent version of the various licensing, administration and server installation guides. The licensing guides included in the NX 11 Help are outdated and should not be used.
Licensing caveats for Windows

The following caveats are applicable to Windows platforms only.

License Option tool

The License Option tool should only be used to borrow NX licenses, even though it may display other licenses. The License Option tool does not filter features in the license file that are of an earlier version than NX 11.0.2, such as Teamcenter lifecycle visualization, so these licenses are displayed in the tool. Attempting to borrow a license other than NX 11.0.2 causes an error in the License Option tool.
Licensing caveats for Linux

Additional software to support licensing

SuSE and Red Hat require the following to be installed:

• LSB 3.0
Licensing caveats for Mac OS X

License server preference settings
The license server used by NX is specified during NX installation, but it may be necessary to view or change the license server setting after installation. To do that, open a Terminal window and use the following commands.

• To read the current license setting:
  
  defaults read /Library/Preferences/com.siemens.plm.nx11

  This command will show the current setting. For example “SPLM_LICENSE_SERVER” = “28000@myserver.mycompany.com”

• To change the license setting:
  
  The following command will set the SPLM_LICENSE_SERVER preference to “myserver1”:
  
  defaults write /Library/Preferences/com.siemens.plm.nx11 SPLM_LICENSE_SERVER myserver1

  You may need to use “sudo” if the Preferences file is writeable only by an administrator. For example
  
  sudo defaults write /Library/Preferences/com.siemens.plm.nx11 SPLM_LICENSE_SERVER myserver1

  You do not need to restart the machine after setting the NX preference.

License server naming on Mac OS X
Mac OS X is different from many other operating systems due to the fact that when the networking conditions change, the hostname of a Mac workstation will change.

For example, while on the network (<mysite>.com), the hostname is mac1.<mysite>.com. While disconnected from all networks, the hostname changes to mac1.local. FLEXnet relies on the use of the hostname to locate the server so this hostname change causes the license server daemons to lose communication and prevents the client application from connecting to the license server. The result is an NX startup error caused by the inability to get a license.

This condition usually occurs when a single user on a laptop installs the license server and NX on the same laptop.

Use one of the following recommendations to help prevent or resolve this situation:

• Install a license server on a workstation or system that has a stable domain. It is recommended that a central license server be used for all client applications.

• Use the local IP address (127.0.0.1) for the hostname as follows.
  
  Change the file from:

  SERVER Yourhostname COMPOSITE=a1234567890b 28000
To:

SERVER 127.0.0.1 COMPOSITE=a1234567890b 28000

When asked for the license server value during the client application install, provide the following:

28000@127.0.0.1

• Request a standalone non-served license file. These license files do not need a license server but simply need to have the application point to a file. These license files are ideal for a user with only one seat of an application that is to be installed on a laptop. Contact your customer service representative for a standalone license file.

Common licensing tool on Mac OS X

The Common Licensing Tool (CLT) for Mac OS X is a licensing utility that enables the user to select bundles and borrow licenses.

Bundle selection

The interface to the Bundle Selection in the CLT for Mac is essentially the same as in the License Options application on Windows.

In order to select a bundle, you highlight the bundle in the Available Bundle list and click the Add button, or double click the selected item. The item is moved to the Selected Bundle list.

To remove an item from the Selected Bundle list and return it to the Available Bundle list, you can highlight the bundle you wish to return to the Available Bundle list and click the Remove button. Alternatively, you can double click the bundle to remove it from the Selected Bundle list.

No bundles are actually applied until you click OK. When you click OK, the modifications to the selected bundle list are written to a file in the user’s home directory, called splms_cl.reg.

The CLT for Mac allows for product-specification in the bundle settings. Thus, the name of the key for the bundle value is <PRODUCT>_BUNDLES, where <PRODUCT> is the product in question (such as NX, in which case the key would be NX_BUNDLES).

Borrowing

Borrowing with the CLT is similar to borrowing with License Options for Windows. To borrow a license feature or features, you select the features that you want and then choose the return date and time. Then you click the Borrow License(s) button. Finally, to perform the actual communication with the license server and borrow the selected items, click OK.

To return a borrowed license, you select the item you want to return, click the Return License(s) button, and then click OK.

The Reset button will cause all Return Dates to go back to the original state they were in when you initially launched the tool. Thus, items that were not borrowed will have their return dates cleared, and any items that had the return date changed or cleared will be reset to their original value when the tool was launched.
Product compatibility - supported version combinations

Teamcenter and NX

The following table lists the version combinations of Teamcenter and NX that are supported.

<table>
<thead>
<tr>
<th>Teamcenter UA</th>
<th>NX 8.5.3</th>
<th>NX 9</th>
<th>NX 9.0.x</th>
<th>NX 10</th>
<th>NX 10.0.x</th>
<th>NX 11</th>
<th>NX 11.0.x</th>
</tr>
</thead>
<tbody>
<tr>
<td>8.3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9.1</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>10.1</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>11.2</td>
<td>✓</td>
<td></td>
<td></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
</tbody>
</table>

(1) Teamcenter UA 8.3.3.6 or higher.
(2) Teamcenter UA 9.1.2 or higher.
(3) Teamcenter UA 10.1.0.1 or higher.
(4) Teamcenter UA 9.1.2.4 or higher.
(5) Teamcenter UA 10.1.0.1 or higher.
(6) Teamcenter UA 10.1.2.2 or higher.
(7) For NX 10.0.2.x:
NX 10.0.2 MP1 or higher with Teamcenter UA 11.2.0 through 11.2.1.x.
NX 10.0.2 MP11 or higher with Teamcenter UA 11.2.2 through 11.2.3.x.
(8) For NX 10.0.3:
NX 10.0.3 or higher with Teamcenter UA 11.2.0 through 11.2.1.x.
NX 10.0.3 MP10 or higher with Teamcenter UA 11.2.2 or higher.
(9) Teamcenter UA 10.1.5 or higher.
(10) For NX 11:
NX 11.0 or higher with Teamcenter UA 11.2.2.
NX 11.0.0 MP3 or higher with Teamcenter UA 11.2.3 or higher.
NX 11.0.1 or higher with Teamcenter UA 11.2.2 or higher.
### NX and Active Workspace with Teamcenter

The following table lists the version combinations of NX and Active Workspace that are supported. The Teamcenter versions listed in each table cell are the minimum versions applicable for both the Active Workspace version and NX version.

<table>
<thead>
<tr>
<th>Active Workspace</th>
<th>NX 9.0.2</th>
<th>NX 9.0.3</th>
<th>NX 10</th>
<th>NX 10.0.1</th>
<th>NX 10.0.2</th>
<th>NX 10.0.3</th>
<th>NX 11</th>
<th>NX 11.0.x</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.1 TC 9.1.2.7</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Active Workspace</td>
<td>TC 9.1.2.10</td>
<td>TC 10.1.2.2</td>
<td>TC 10.1.2.2</td>
<td>✔</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2.2 TC 10.1.1.1</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Active Workspace</td>
<td>TC 9.1.3.1</td>
<td>TC 10.1.2.3</td>
<td>TC 10.1.2.3</td>
<td>TC 10.1.3</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2.3 TC 10.1.2.1</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Active Workspace</td>
<td>TC 9.1.3.4</td>
<td>TC 10.1.4</td>
<td>TC 10.1.4</td>
<td>TC 10.1.4</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2.4 TC 10.1.4</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Active Workspace</td>
<td>TC 10.1.5</td>
<td>TC 10.1.5</td>
<td>TC 10.1.5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3.0 TC 11.2.1</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Active Workspace</td>
<td>TC 10.1.5</td>
<td>TC 10.1.5</td>
<td>TC 10.1.5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3.1</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
</tbody>
</table>

**Note**

For information on version compatibility for Teamcenter and Teamcenter lifecycle visualization, see the Teamcenter documentation.

---

1-30  NX 11.0.2 Release Notes
<table>
<thead>
<tr>
<th>Active Workspace</th>
<th>TC 10.1.5</th>
<th>TC 10.1.5</th>
<th>TC 10.1.5</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.2 TC 11.2.1</td>
<td>TC 11.2.2</td>
<td>TC 11.2.2</td>
<td></td>
</tr>
</tbody>
</table>
NX compatibility with Spreadsheet

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows</td>
<td>Windows 10 64-bit</td>
<td>10 Pro &amp; Enterprise</td>
<td>10 Pro &amp; Enterprise</td>
<td>Supported</td>
<td>Supported</td>
<td>Supported</td>
<td>Not supported</td>
<td>Supported</td>
<td>Supported</td>
<td>Not supported</td>
<td>Supported</td>
</tr>
<tr>
<td>Windows</td>
<td>Windows 8 64-bit</td>
<td>8 Pro &amp; Enterprise</td>
<td>8 Pro &amp; Enterprise</td>
<td>Supported</td>
<td>Supported</td>
<td>Certified</td>
<td>Not supported</td>
<td>Supported</td>
<td>Certified</td>
<td>Not supported</td>
<td>Certified</td>
</tr>
<tr>
<td>Windows</td>
<td>Windows 7 64-bit</td>
<td>7 Pro &amp; Enterprise</td>
<td>7 Pro &amp; Enterprise</td>
<td>Supported</td>
<td>Supported</td>
<td>&amp; supported</td>
<td>Not supported</td>
<td>Supported</td>
<td>&amp; supported</td>
<td>Not supported</td>
<td></td>
</tr>
<tr>
<td>Linux</td>
<td>Suse</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Certified</td>
</tr>
<tr>
<td>Linux</td>
<td>SuSE</td>
<td>12</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Linux</td>
<td>Red Hat</td>
<td>Enterprise V7</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Note

- The NX spreadsheet interface is not supported on the MAC platform in NX 11.0.x.
- The 64-bit versions of Microsoft Excel are not yet supported by NX. The 32-bit version of Excel is installed by default on the Windows 64-bit Operating Systems.
- Microsoft Starter Edition is not supported by NX due to lack of support for Add-in's, Macro's, Math and Equation Editing.
- If you open a part with Excel 2003 data or older and then save the spreadsheet, NX updates the data to Excel 2007 or later (to the Excel version currently running with NX).
- If you launch a spreadsheet command such as Spreadsheet or Part Family on a system having Excel 2003 or older version as the default spreadsheet application, NX displays an error message and does not proceed with the launched command.

1. When you launch Excel 2016 spreadsheet from NX and exit the spreadsheet using the Windows Close button, Excel launches a dialog box prompting you to either accept the changes, discard the changes and exit, or to cancel the spreadsheet exit. If you select the cancel operation, subsequent use of the Windows Close button will close the spreadsheet without displaying the dialog box described above and does not return control back to NX. At this point, you may need to terminate the NX process. To avoid this situation use the Excel File tab—Close command instead of the Windows Close button. A fix for this issue is expected in a future version of Microsoft Excel 2016.
# NX applications unsupported on specific platforms

The applications listed are not supported on the specified platforms.

<table>
<thead>
<tr>
<th>Application</th>
<th>Functionality</th>
<th>Platform</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gateway</td>
<td>File Print</td>
<td>Not supported on: Linux, MAC</td>
</tr>
<tr>
<td></td>
<td>File Open of SolidWorks files</td>
<td>Not supported on: Linux, MAC</td>
</tr>
<tr>
<td></td>
<td>Advanced Studio Rendering Style Mode</td>
<td>Not supported on: Linux, MAC</td>
</tr>
<tr>
<td>Plotting</td>
<td>Plotting of high quality images using the <strong>View</strong>→<strong>Visualization</strong>→<strong>High Quality Image</strong> command</td>
<td>Not supported on: MAC</td>
</tr>
<tr>
<td>Manufacturing Milling</td>
<td>Siemens 840D virtual machine tool controller (VNCK)</td>
<td>Not supported on: Linux, MAC</td>
</tr>
<tr>
<td></td>
<td>Manufacturing Wizard Builder (part of Simulation Process Studio)</td>
<td>Not supported on: Linux, MAC</td>
</tr>
<tr>
<td>Pre/Post</td>
<td>Abaqus OBD result file reading</td>
<td>Not supported on: Linux, MAC</td>
</tr>
<tr>
<td></td>
<td>Topology Optimization and Shape Optimization</td>
<td>Not supported on: Linux Redhat, MAC</td>
</tr>
<tr>
<td>Design Simulation</td>
<td>All</td>
<td>Not supported on: MAC</td>
</tr>
<tr>
<td>Motion</td>
<td>Motion Mechatronics co-simulation</td>
<td>Not supported on: Linux, MAC</td>
</tr>
<tr>
<td>Teamcenter Integration</td>
<td>Launching NX from Active Workspace web client</td>
<td>Not supported on: MAC</td>
</tr>
<tr>
<td>Human Modeling</td>
<td>All</td>
<td>Not supported on: Linux, MAC</td>
</tr>
<tr>
<td>PCB Exchange</td>
<td>Automatic creation of ESC solution</td>
<td>Not supported on: MAC</td>
</tr>
<tr>
<td></td>
<td>CR5000 pcb files Import / Export / Compare (PCB Exchange for Zuken limitation)</td>
<td>Not supported on: Linux, MAC</td>
</tr>
<tr>
<td>Mechatronics Concept Designer</td>
<td>All</td>
<td>Not supported on: Linux, MAC</td>
</tr>
<tr>
<td>CMM Inspection Programming</td>
<td>All</td>
<td>Not supported on: Linux, MAC</td>
</tr>
<tr>
<td>Simple NX Application Programming (SNAP)</td>
<td>All</td>
<td>Not supported on: Linux, MAC</td>
</tr>
</tbody>
</table>
Support for touch enabled devices

In NX 11, you can interact and manipulate 3D models and control the overall user interface using touch screen and stylus. The support for touch enabled hardware follows a slightly different support model than what is provided through the NX certification program. We have tested NX on a number of Windows based touch screen laptops, monitors, and tablets. However, support for these devices and other comparable systems is limited as they are not true workstations and do not qualify for our full certification program. Support for these devices is limited as follows:

• Graphics performance issues are not supported as most of these devices do not offer the level of driver support available on workstations.

• Graphics quality and display issues are not supported unless they can be duplicated on a certified workstation.

• Any issue determined to be caused by the graphics driver is not supported.

• Performance issues with NX are not supported on these systems unless reproducible on certified workstations.

Caveats aside, we have tested and used for development a variety of touch based systems from HP, Dell, Microsoft, and others and have found them acceptable for general usage of NX.

Additional Notes

• NX supports touch devices on Windows 7, Windows 8, and Windows 10 operating system.

• Only stylus configurations support pre-highlighting. The most commonly used devices supporting stylus are the Surface Pros.
Chapter 2: Teamcenter Integration for NX
Product Notes

Use Item Name instead of Number customer default

The **Use Item Name instead of Number** customer default is removed. To specify the display of the Item name or Item ID for an object in NX, specify the desired property as the displayed property in the Teamcenter BMIDE. NX uses the same setting as Teamcenter. This provides consistency for displayed names when viewing objects in Teamcenter and NX.

In addition, the **Always use Item Number for Interpart Expressions** customer default is removed.

Part number and revision customer defaults

The **Part Number Prefix**, **Part Number Suffix**, **Part Revision Prefix**, and **Part Revision Suffix** customer defaults are moved to the **Legacy** tab. They are available for systems using legacy display names and to support NX Open programs. The NX Part Display Name is now based on the display name as defined in Teamcenter.

Variant configuration

The **Variant Configuration** command is removed. To apply a variant configuration to an assembly, load the assembly using the **Variant Rule** option in the **Assembly Load Options** dialog box.

Teamcenter names and values of properties localized

In Teamcenter, there is now the capability to have the **names** and **values** of properties translated and displayed in multiple languages. You can see this functionality in some areas of NX (not all areas of NX incorporate this functionality), such as the Part Family template spreadsheet, and New Item, Save, Save As, Import, and component properties dialog boxes. This is applicable for Teamcenter properties such as: property names, property values, list of values, and BMIDE elements (type names).

**Note**

This functionality is applicable for Teamcenter 11.2 or higher.

When you run NX, the language set by the environment variable **UGII_LANG** determines the language that is used to display the **names** and **values** of TC properties in NX.

If you do not have translated **values** defined in TC for the properties, or you do not want NX to display the translated **values**, set the following environment variable:

**UGII_NO_TC_LOCALIZATION=1**

When this environment variable is set, the property **values** shown in NX are always the internal value (non-translated) and there is no indication in NX that the value has a translated value defined in Teamcenter. This is the same behavior that NX had prior to NX 10. However, the environment variable does not change the way the property **names** are displayed. If the property **name** has a translated value that matches the **UGII_LANG** setting, the translated (localized) **name** is still shown in NX.
Caveats

Running refile with escape character

If you set the following Teamcenter preference to # so that # becomes an escape character, refile does not work for a part that contains the # character in its ID.

TC_escape_character

Starting NX in four-tier Teamcenter environment with WebLogic 10 MP2

When you are running Teamcenter in the four-tier environment with WebLogic 10 MP2, NX may not start with no error messages displayed. This could be due to problems with the WebLogic server.

Note
This is applicable only when you are using the WebLogic 10 MP2 Application Server.

Perform the following steps to modify the Weblogic XML file:

1. Stop the WebLogic application and locate the tc.war file in the WebLogic domain (typically in the autodeploy directory).

2. Open the tc.war file using Winzip and extract the weblogic.xml file to a temporary location.

3. Open the weblogic.xml file using an editor (XML or text editor) and add a cookie-http-only XML element with the value of false in the session-descriptor element. For example:

   ```xml
   <session-descriptor>
   ...  
   <cookie-http-only>false</cookie-http-only>
   </session-descriptor>
   ```

4. In Winzip, delete the old weblogic.xml file.

5. Add the modified weblogic.xml file in your temporary directory into Winzip. To do this, drag the web-inf folder that contains the weblogic.xml file and drop it into Winzip. Ensure the path of the weblogic.xml file is web-inf/.

6. Restart the WebLogic application.

Creating an Alt Rep assembly using File New

You cannot have an assembly that is an alternate representation (Alt Rep) that has children that are not also Alt Reps. The part types of the parts (Alt Rep) must match the part type of the assembly (Alt Rep).

However, when you choose File→New to create a new assembly and use the Blank template, NX lets you create an Alt Rep assembly with children that are not also Alt Reps. This causes problems when you use the assembly in NX.
Translators only supported in Teamcenter two-tier environment

Teamcenter only supports the installation of the following NX translators in a Teamcenter two-tier environment, the Teamcenter four-tier environment is not supported:

- NXClone
- NXRefile (not supported on Linux)
- NXtoPVDirect

VLA Attribute Affix options modified

The VLA Attribute Affix customer default (Teamcenter Integration for NX—User Attributes, All tab) is modified. The new options [Numeric] and :Numeric introduced in NX 8 caused problems when there are references to VLA (variable length array) attributes in parts created prior to NX 8. The [Numeric] and :Numeric options are now set to _Numeric when selected. You should use _Numeric if you are setting this option for the first time.
Chapter 3: Fundamentals
Product Notes

Classic Toolbar user interface retired from the Windows platform

The Classic Toolbar user interface is retired from NX11 and the Ribbon Bar is the only available user interface on Windows. The Ribbon Bar interface provides access to more commands than the Advanced role in Classic Toolbar mode with a larger graphics window. And it does all this with logical groupings, informative text and a mixture of icon sizes. In addition to these traditional aspects of the Ribbon Bar, the NX ribbon is fully customizable and contains NX-specific extensions such as border bars. The result is a more organized user interface with the richness of Advanced and the discoverability of Essentials.

For instructions on how to migrate from Classic interface to Ribbon bar interface, see NX Ribbon-Customization and Transition.
Caveats

Bookmarks

If you create a bookmark file with Ray Traced Studio mode enabled, when the bookmark is applied Ray Traced Studio mode will not be in effect.

If you create a bookmark file when displaying a View Section with clipping disabled, when the bookmark is applied the section may be incorrectly clipped.

If you try to apply a bookmark file when

1. the bookmark file is not for the current displayed part and
2. the number of views in the layout at the time when the bookmark file was created is not the same as the number of views in the current displayed part

then the number of views in the layout may be wrong after the bookmark file is applied. Applying the same bookmark file a second time corrects the number of views.

Ray Traced Studio

To maximize rendering performance for NX 11.0.1, you need an NVIDIA GPU with CUDA Compute Capability 2.0 and higher, and a graphics driver supporting CUDA 8.0 or higher (For NVIDIA driver version, contact GTAC)

Note

Users upgrading to NX11.0.1 may need to upgrade to a later NVIDIA graphics driver version for CUDA 8.0 support.

Because some driver versions supporting CUDA 8.0 have incorrect documentation stating they only support CUDA 7.5, the NVIDIA Control Panel should be checked to verify the actual CUDA version supported.

Tip

The current CUDA version supported by the NVIDIA graphics driver can be obtained using the NVIDIA Control Panel→System Information→Components tab→3D Settings→<Product Name for NVCUDA>
Using Teamcenter as the issue site for NX Issue Management

When you use NX Issue Management, you can specify Teamcenter as the issue site only when Teamcenter Issue Manager is deployed via Teamcenter Environment Manager at the server side. NX displays an error message if it cannot connect to Teamcenter Issue Manager. For more information, refer to the Teamcenter Environment Manager Help.
Chapter 4: Customer Defaults
Customer defaults

Customer defaults allow you to customize the operation of NX. The initial settings and parameters of many functions and dialog boxes are controlled by customer defaults. You can view them by choosing File→Utilities→Customer Defaults.

For a description of the new/modified customer defaults for this release, see Customer Defaults for NX 11.0.2.

For additional information on customer defaults, see System administration→Customizing the NX installation→Customer Defaults in the NX online help. For a listing and description of all customer defaults, see Fundamentals→Customer Defaults in the NX online help.
Chapter 5: CAD

Modeling

Product Notes

History-Free Mode retired in NX 11

After careful consideration and extensive research we have decided to stop offering History-Free Mode in NX. We have many reasons to believe that using History Mode offers a more complete and compelling solution. Our experience has shown us that the vast majority of you are making use of the power of Synchronous Technology in History Mode and we will continue our focus in that area. Over time we will consider implementing the small number of unique History-Free capabilities in History Mode.

History-Free Mode will be retired with the NX 11 release. As part of this plan, creating a History-Free part or converting a History part to a History-Free part will no longer be supported. History-Free parts created prior to the NX 11 release will continue to be supported. You will be able to open these parts in NX 11, and they will continue to work in History-Free Mode.

Commands being retired in NX 12

The following commands will be available in NX 11 only through environment variables, and will be fully retired and dropped from the product line in NX 12:

• **Move Defining Point (to be retired)** - Restore with NX_MOVE_POINT_ON environment variable.

• **Move Pole (to be retired)** - Restore with NX_MOVE_POLE_ON environment variable.

• **Isoparametric Trim/Divide (to be retired)** - Restore with NX_ISO_TRIM_ON environment variable.

**Spline (to be retired)**

The legacy Spline command is to be retired in a future release of NX and is now hidden. It is recommended that you use the Studio Spline command instead. Until it is retired you have the option to bring the legacy Spline command back to NX under its new name, Spline (to be retired), using the Customize command.

**Thicken gash removal**

The Remove Gashes option in the Thicken command has been renamed to Improve Gash Topology to Enable Thickening.
Caveats

Flattening and Forming limitation with Pattern Feature and Mirror Feature

You cannot select a Flattening and Forming feature as input to the Pattern Feature or Mirror Feature commands if the Flattening and Forming feature includes curves or points as Transformation Objects.

Expressions dialog box

- Undo is currently not well supported in the Expressions dialog box.
- Creating interpart expressions in 4GD structures may produce unexpected results.

End Object selection for Face/Plane Normal vectors

When creating vectors using the Face/Plane Normal type, you can currently use the Face Rule selection intent option to select objects only if you are in the Modeling application.

Enhancements to start options for Point on Curve / Edge features and offset point options

When you edit points created using the Start Point option, certain selection scenarios may cause the Redo command to fail.

When you edit one of the following features, the on-screen input dialog box that appears may not match the on-screen input box that was displayed when you created the feature:

- A Point on Curve/Edge feature
- A Datum Axis feature creating using the Point and Direction type
- An Edge Blend feature

Note

The preview display of an Edge Blend feature may disappear when you edit the feature.

In the preceding cases, use the feature's dialog box for editing rather than the on-screen input boxes.

Renew Feature

Features directly used as references in Pattern Feature or Mirror Feature are not supported for renewal by Renew Feature.
Drafting

Product Notes

Importing I-deas files

If you want to import I-deas .asc or .dwg files, please be advised that starting with NX11 you must manually install I-deas ASC/DWG Importer files in addition to the NX installation. If these files are not installed the following message is shown when you try to import a .asc or .dwg file:

```
The I-deas ASC/DWG Importer files were not found.
Refer to the NX release notes and documentation.
```

The I-deas ASC/DWG Importer files are available on the GTAC site from the NX download page. They are located in the Product Updates→Drafting folder. To properly install the files, please follow the instructions contained in the I-deas ASC/DWG Importer README file.

Assemblies

Caveats

Component patterns

When the setting of your Move Component Scope customer default is Anywhere in Assembly, NX ignores this setting if the displayed part or any of its subassemblies contain any component patterns. When you move components in this situation, the Move Component command behaves as though the Move Component Scope customer default is set to Work Part Only.

When a subassembly of the displayed part contains a component pattern, inserting a motion step in your sequence that affects a member of the component pattern may cause incorrect movement of the following:

- Members of the component pattern.
- Components directly constrained to the pattern members.
- Components indirectly constrained to the pattern members.

Note

When component patterns are present only in the displayed part, the Insert Motion command works correctly.
Data Reuse

Caveats

CADENAS Library in the Reuse Library

The CADENAS Library is not yet available. It will be provided in a later release.

Sheet Metal

Caveats

Exporting multi-segment lofted flanges to Trumpf GEO format

Flat Pattern of a model that contains multi-segment lofted flanges cannot be exported to Trumpf GEO format.

Unite in Sheet Metal

If you unite bodies that consist of Sheet Metal and advanced Sheet Metal features, the united body may not support subsequent Sheet Metal operations.

Gusset line representation in flat pattern

Gusset line representation in flat pattern may not appear for the gussets that are created on cylindrical segments of chained bends of advanced and contour flanges.

Routing

Caveats

Placement of eccentric reducers

If the NPS and NPS_BRANCH attributes are not present on the ports of a reducer, you might not get the correct placement solution while placing the pipe. If you place such a part, you might not be able to move it as expected using the Move Part command.

Moving parts

You cannot move a routing component using the Move Part command if the customer default for the selection scope of the Move Component command is set to Anywhere in Assembly.

Tip

To find a customer default, choose File tab→Utilities→Customer Defaults, and click Find Default.
Color bleeding in harness displays

If the color bleeds through in the display of harnesses, use the Refinement Factor visualization preference to correct the display. The factor you must set varies depending on the part that is open.

In the Visualization Preferences dialog box→Faceting tab→Part Settings group, use the:

- Shaded Views subgroup→Refinement Factor option to adjust the display in a shaded view.
- Advanced Visualization Views subgroup→Refinement Factor option to adjust the display in advanced studio views.

Teamcenter Classification

The Teamcenter Classification plug-in is now obsolete. You can use the out-of-the-box support for classification by setting the Teamcenter classification options in the Part Library customer defaults.

Tip

To find a customer default, choose File tab→Utilities→Customer Defaults, and click Find Default.

You can use the Reuse Library for classification without setting up additional plug-ins.
Documentation Notes

Structure of a PTB file

The topic Structure of a PTB file erroneously states that NX uses the descriptor characteristics in the list of table columns in a PTB file to search for parts in the Routing Reuse Search dialog box. In reality, NX only displays the characteristics in the Routing Reuse Search dialog box. The switch /HIDE indicates that you do not want NX to show the characteristic in the Routing Reuse Search dialog box during part placement.

Note that the destination characteristics defined under specific disciplines in the APV file are used when you search for parts. This is not necessarily the same as what is displayed.

Unify Path enhancement

In previous releases, NX did not unify paths when direct mount parts or eccentric segments were a part of your selection. Parts that were placed using the Instance Name Lookup command and which were part of a run were ignored when you used the Unify Path command.

In NX 9.0.2 and later, in addition to the conditions mentioned above, NX does not unify a path that has an eccentric reducer part or any other routing part which has the NX_BLOCK_UNIFY attribute set to TRUE in the respective PTB file.

Parts which are placed using the Instance Name Lookup command are now ignored when you use the Unify Path command, even when the parts are not part of a run.
Product Notes

Propagation of attributes on a run

NX does not automatically propagate attributes that are specific to a run to the Member items of the run.

To see all the run-level attributes of the member of a run, such as a component or a segment, right-click the object in the graphics window and choose Report Run Attributes.

PLMXMLViewer configuration

The PLMXMLViewer uses the configuration saved in the registry. When you open the PLMXMLViewer, it opens according to the last configuration that was used based on what is saved in the registry.

To open the PLMXMLViewer with a different configuration, create a new configuration file, and use the Display Formats command in the View menu to save the new configuration file to the registry.

Qualify parts using stock offset

When you place a part that has been qualified with a stock offset, Routing automatically adds a fixed constraint to the component. NX designates the fixed constraint with the Offset Constraint label. NX also adjusts the stock offset according to the stock diameter and ensures that the component will not move when a segment with stock is attached to the port or when you use the Move, Move Part, or Move Path commands.

Renaming stock components in Teamcenter Integration for NX

To change the name of a stock component that is not yet saved, use the Rename Stock command.

To change the name of a stock component that is saved, use the Make Unique command or the Save As → New Item command.

Retired functionality in Routing

The following are retired for NX 11.

- **Active Routing Level** Routing preference
- **Display Segment Constraints** Routing preference
- **Manage Associative Paths** command
- **By Poles** option in the Spline Path dialog box
- **Variant Conditions** command
- **Variant Configurations** command

The following Routing plug-ins are retired for NX 11.

- ROUTE_CHOOSE_PART_PLACE_PART
Automatic fix constraint on Stock Offset Ports

In NX 9.0.2 and higher, NX adds an automatic fix constraint to every Stock Offset Port component to keep the component from moving when you connect a segment to the offset port.

This constraint is called Offset Constraint in Assembly Navigator and Constraint Navigator. If you change the name, NX reverts to the original name when the automatic fix constraint is recreated.

If you suppress the constraint, the component is free to move till you unsuppress the constraint.

If you add a new fix constraint, NX deletes the automatic fix constraint. If you delete the fix constraint that you added, NX again creates an automatic fix constraint.

You cannot move a Stock Offset Port component while editing an existing constraint using the Assembly Constraints dialog box. You can move a Stock Offset Port component while creating a new constraint using the Assembly Constraints dialog box. You can move or transform a Stock Offset Port component using the Move Component or Transform Path command if the only fix constraint on the component is the automatic fix constraint.

In case of conflicts with other constraints, NX displays a warning. In order to resolve such conflicts, you can remove or suppress the constraints that you have created or you can suppress the automatic fix constraint.

Installing standard parts to Classification in Teamcenter Engineering TC9.1

You can install standard parts to Classification in Teamcenter Engineering TC 9.1 by using the Classification Install for Part Library tool provided in the following folder:

UGII_BASE_DIR\ugroute_mech\classification_tool

Opening pre-NX 10 parts in later releases

Opening pre-NX 10 parts might take longer when you open the part for the first time in a subsequent release.

Upgrade Stocks command

When using the Upgrade Stocks command on a part that uses Stock As Components and that has multiple levels of Routing assemblies, we recommend that you select the Work Part and Loaded Children Parts check box.
Ship Structure

Caveats

Copy Parts between Planes

The Copy Parts between Planes command does not support Extrude features that are created using the Stop at Intersection selection rule.

CAE Preparation

The Openings Less Than Diameter option in the CAE Preparation dialog box is currently not supported.

Product and Manufacturing Information (PMI)

Documentation notes

More about PMI hole callouts

Because the associated object for a PMI hole callout is the hole feature, rather than the geometry of the hole itself, the following points should be considered when creating and reusing a PMI radial or linear hole callout dimension.

- You have to select the hole feature itself when creating a PMI hole callout. Therefore, the callout must reside in the part that contains the feature. You can use PMI assembly filters if you need to display the PMI hole callout from a component in the context of an assembly.

- While most PMI annotations can be freely stacked, the PMI hole callout dimension cannot be added to a stack because doing so would break the necessary association with the hole feature. Other PMI annotations can be stacked onto a hole callout. In this case, the stacked PMI inherits an association with the hole feature faces, and not the hole feature itself.

- The Find PMI Associated to Geometry command only returns a PMI hole callout if the associated hole feature is selected. If you select a face from the feature, instead of the feature itself, the PMI hole callout will not be returned unless the face itself has been identified as an associated object.

- PMI hole callouts cannot be WAVE linked. This is because features are not WAVE linked, only bodies or topological entities can be WAVE linked.

- PMI hole callouts can not be mirrored. This is because only a body can be mirrored; a feature cannot be mirrored.

- If additional model edits have affected the parameters of a hole callout, the hole callout will reflect the actual state of the hole feature, and not the original modelled state of the feature.

- Additional hole callout limitations may apply if a pattern of holes is created with a single hole feature. For example, multiple holes created from points in a single sketch.
PCB Exchange

Caveats

Flat Solid workflow

The import and export of ECAD models in their bend state only works when the board is a solid body. If the board is an assembly component this workflow does not work.

PCB Exchange for Zuken

CR5000 Data Server version 16 or earlier requires the Visual C++ 2008 Redistributable package to be installed. You can download it from the Microsoft website.
Chapter 6: CAM

Manufacturing Product Notes

Manufacturing Product Notes

The Manufacturing product notes describe product changes that are not included in the What’s New in NX documentation.
CAM Early Access program

Some of the new NX CAM features are available only upon request through the CAM Early Access Program. In order to learn more about these pre-release features, please contact GTAC. GTAC will forward your request to the appropriate development contact.
Tool path and template changes

PAX file change

The .pax files are now located in the `UGII_BASE_DIR\mach\templates` folder.

Tool path changes

A general reminder: There are ongoing changes in the processors to fix problems, add enhancements, and improve reliability. In many cases, you may see some differences between the new path and the old path when you generate an operation from a previous release. If you rely on automatic methods, these changes should be acceptable. The end result of the new path should be comparable to, or better than, the previous path.

CAM configuration changes

- Configuration file hole_making.dat was removed.
- Key MACHINING_KNOWLEDGE was added to all configuration files.

Operation template sets

- drill.prt, machining_knowledge.prt and mill_feature.prt are obsolete and were hidden in all template sets where they occur. The operation template part files themselves are left in place for now. They can still be used as before by either browsing to their location or removing the ## hidden tag in the opt files.
- Removed entries drill.prt and machining_knowledge.prt from template.dat (used by configurations having key LIBRARY_SETUP_TEMPLATE).
- Added entry mill_planar.prt and mill_contour.prt to some Express configurations.
- Template sets feature_machining.opt, hole_making.opt, mill_multi-axis_hsm.opt and nc_grip.opt are not referred to in any cam configuration, but are left in place for now.

Operation template parts

- legacy_lathe.prt was removed
- Operation type manual_hole_making is obsolete and removed from hole_making.prt
- drill.prt, hole_making_mw.prt, machining_knowledge.prt and mill_feature.prt are obsolete but left in place for now.

NX 11.0.2:

- In mill_multi-axis.prt, in the TUBE_FINISH operation, the values for the Tool Axis fields are corrected.
- In turning.prt, the templates are corrected to inherit the Turn Orient WCS mapping of XC and YZ.
- In library_dialogs.prt, the PROFILE_3D operation is added.
Merging customized templates

You can merge your customized templates with the templates included in this release in the following ways:

- Start with the new default templates and apply your customizations. This is *highly recommended* to ensure you receive all the PR fixes.

- Re-file your customized templates in the new release, review the changes listed for the release, and implement the applicable ones in your templates. This method is not recommended, because you will not receive the PR fixes.
General changes

Paste with Reference enhancements

The Paste with Reference command now supports wave links and the new manual drilling operations.

2D Dynamic collision display when verifying a tool path

In previous releases, rapid tool motions through the Part, Blank or IPW were displayed in the red gouge color as material removed. In the current release, the material removal from these tool motions is not displayed, so you will not see these collisions. To check for collisions, do one of the following:

- Click List after the simulation stops.
- Click Collision Settings. In the Collision Settings dialog box, select the Pause on Collision check box to stop the visualization when a collision occurs. This option does not work if you step through the operation.

User Defined Operation and API Enhancements

The User Defined Operation API now has the ability to:

- Use the 3D milling IPW from a previous operation as the blank.
- Write level markers to the tool path. In verify, a tool path will have the ability to display one level at a time, just like a Cavity Milling operation.

Machine Tool changes

The standard machine tools supplied with NX have revised postprocessors and kinematics models. Review all existing Manufacturing setups which use a standard machine tool from a release prior to NX 8. If necessary, retrieve the machine tool again.
Integrated Simulation and Verification (ISV)

Installed machines and simulation samples

For information about how to use the standard installed machines and simulation samples included with NX, see the Working_with_OOTB_MACH_Simulation_Examples.pdf file in the mach\samples\nc_simulation_samples folder of your NX installation.

Postprocessors for installed machines

The NX 11 machine library includes setups with posts created using PostConfigurator and posts created using Post Builder. The Post Builder setups include the post units in their name. For example, sim01_mill_3x_sinumerik_in.

ISV Simulation

• If the spindle speed is zero for an operation, then no material is removed from the IPW.

• Internal and external simulations now use the same geometry definitions for the part and the workpiece. You must assign the geometry to the related kinematic model components, which are classified as _PART and _WORKPIECE.

If a legacy part does not have geometry defined in the kinematics model, NX uses the geometry defined in the Operation Navigator for internal simulations.

• External file simulation in Teamcenter Integration for NX uses the same file selection box as native NX.

• CSE simulation with the Sinumerik 840D controller has improved inch unit handling. When you use inch units:
  o The values inside the to_ini.ini file must also be in inches.
  o The variable values in the to_ini.ini file created by older Sinumerik posts must also be in inches. If they are not, use one of the standard posts provided with NX instead.

• The CSE Machine Configurator version 1.0.0.1012 supports file extensions. We recommend that you use the latest version of the Machine Configurator, because future CCF files shipped with NX will include file extensions.

• For the option Show Tool Path, NX determines which machine component to attach the tool path to in the following way:
  1. In the Operation Navigator, NX finds the part geometry of the current operation.
  2. In the kinematics model, NX looks for a machine component which has the part geometry attached.
     o If the part geometry is found, NX attaches the tool path to that machine component, regardless of its classification.
     o If the part geometry is not found, NX attaches the tool path to the first machine component classified as _PART.
• For the option **Show Tool Trace**, NX attaches the tool trace to the first machine component classified as _PART_.

**Customizing the Simulation Control Panel dialog box Speed slider behavior**

If your simulation is too fast or too slow, you can change the **Speed** slider behavior by specifying a different **Minimum Simulation Time** value. For a faster simulation, you increase the **Minimum Simulation Time** value. For a slower simulation, decrease the **Minimum Simulation Time** value.

NX uses the following formula to calculate how often to display an update during simulation.

\[ \text{MST} \times 2^{(n-1)}, \text{ or } \text{MST} \times 2 \text{ to the power (n-1)} \]

where:

• \( n \) is the slider setting.

• MST is the **Minimum Simulation Time** setting from the Manufacturing setup or the library machine tool.

The longer the time between display updates, the faster the simulation. For example, if the tool path to simulate is 100 machining seconds long, and the display updates every 1 second of machining time, then NX must update the display 100 times for the simulation. If the display updates every 5 seconds of machining time, then NX updates the display 20 times for the same simulation, and the simulation runs faster.

**Note**

The MST value must be a multiple of the cycle time. If it is not, NX displays an alert and rounds the value to a multiple of the cycle time set on the **General** tab in the **Machine Configurator** (MCF) dialog box.

For VNCK simulations only, NX takes the cycle time directly from the booted VNCK and ignores the MCF entry.

In the following examples, the cycle time is 5 milliseconds (.005 seconds). The calculated value indicates how often NX updates the display.

<table>
<thead>
<tr>
<th>MST = .005</th>
<th>MST = .009</th>
<th>MST = .05</th>
</tr>
</thead>
<tbody>
<tr>
<td>• ( n = 1 )</td>
<td>• ( n = 1 )</td>
<td>• ( n = 1 )</td>
</tr>
<tr>
<td>(.005 \times 2^0 = .005 \times 1)</td>
<td>(.01 \times 2^0 = .01 \times 1)</td>
<td>(.05 \times 2^0 = .05 \times 1)</td>
</tr>
<tr>
<td>= .005 seconds</td>
<td>= .01 seconds</td>
<td>= .05 seconds</td>
</tr>
<tr>
<td>• ( n = 2 )</td>
<td>• ( n = 2 )</td>
<td>• ( n = 2 )</td>
</tr>
<tr>
<td>(.005 \times 2^1 = .005 \times 2)</td>
<td>(.01 \times 2^1 = .01 \times 2)</td>
<td>(.05 \times 2^1 = .05 \times 2)</td>
</tr>
<tr>
<td>= .01 seconds</td>
<td>= .02 seconds</td>
<td>= .1 seconds</td>
</tr>
<tr>
<td>• ( n = 3 )</td>
<td>• ( n = 3 )</td>
<td>• ( n = 3 )</td>
</tr>
<tr>
<td>(.005 \times 2^2 = .005 \times 4)</td>
<td>(.01 \times 2^2 = .01 \times 4)</td>
<td>(.05 \times 2^2 = .05 \times 4)</td>
</tr>
</tbody>
</table>
### Chapter 6: CAM

<table>
<thead>
<tr>
<th>Release</th>
<th>MST value in the machine tool</th>
<th>Cycle time from MCF (milliseconds)</th>
<th>MST value used for display update</th>
</tr>
</thead>
<tbody>
<tr>
<td>NX 10.0.3 MP5 and earlier</td>
<td>.01</td>
<td>5</td>
<td>0.005</td>
</tr>
<tr>
<td>NX 10.0.3 MP6 and later</td>
<td>.01</td>
<td>5</td>
<td>0.01</td>
</tr>
<tr>
<td>NX 11 and later</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### ISV using CSE simulated controllers with Python parser

- The CSE Python parser is supported for Windows only.

  This means that the standard examples supplied with NX will not run on non-Windows operating systems. As a workaround: Inside the Machine Configurator, in the **Global Settings** dialog box, change the **Implementation** setting for the MCF from **Python** to **Library**.

- For existing simulations using Python parser with encrypted files from older versions, for example NX 9 or NX 10, we recommend that you use the un-encrypted *.py files from the installed NX 11.0, NX 11.0.1, or NX 11.0.2 release.

### Virtual NC Kernel (VNCK)

To run an external file machine tool simulation properly, all channels of the machine tool model that can be assigned a main program must exist in the kinematics model before you start VNCK.

### Active Tool

In **Verify** and tool path based simulation, the active tool is always the one that is associated with the current operation in the **Machine Tool** view of the **Operation Navigator**.

In CSE simulation, you can have multiple tools active for each channel.

- You activate the tool for a channel using the AnyController command `activateNextTool()`.

- There is one active tool per turret or spindle carrier. The total number of active tools is limited by the number of carriers.

- For material removal, NX takes every active tool in the channel of the current motion into account.

- For collision detection, including gouge check, NX only considers the last active tool in a channel.
Turning

Threading operations

When you machine conical threads with multiple starts, the engage and retract behavior is different. This is because NX now calculates the pitch distance of conical threads along the centerline of the cone. In versions prior to NX 11, NX calculated this distance parallel to the surface of the cone.
Hole machining

Feeds and Speeds - Set Machining Data

For a step drill tool, NX calculates the spindle speed based on the tip diameter.

Back Counter Sinking operation

The collision check fails if you do not use a pre-drill operation, or when the pre-drilled hole is too small. This is because the spindle is in non-spinning mode when it moves through the hole, and non-spinning tools do not report collisions.
Feature-based Machining (FBM)

Feature teaching no longer supports the *Inferred* CSYS subtype.
Manufacturing critical maintenance and retirement notices

Manufacturing Wizard Builder

The Manufacturing Wizard Builder is on critical maintenance. It is a plug-in for the Process Studio Author (PSTUDIO) application, which is no longer being developed. The 32 bit version is included in the NX installation, and there is no plan to discontinue this.

The location in the Windows start menu has changed. Choose Start→All Programs→Siemens NX 9.0→Manufacturing→Process Studio Author

There are no plans to discontinue CAM Wizards, which are xml files based on our block based UI architecture.

Point To Point planned retirement from all platforms

Point To Point is in critical maintenance. The Drill template has been hidden by default, but is still available.

The following operations and geometry objects in the Drill template are affected:

• DRILL_GEOM
• SPOT_FACING
• SPOT_DRILLING
• DRILLING
• PECK_DRILLING
• BREAKCHIP_DRILLING
• BORING
• REAMING
• COUNTERBORING
• COUNTERSINKING
• TAPPING

The hole drilling operation introduced in NX 9 should be used instead of the Point To Point module. The new method to manually drill holes will fully replace the Point To Point module over the course of the next one to two releases.

The migration of Point To Point operations is not committed at this time, but will be considered for a future release.

The new method to manually drill holes not only replaces the Point To Point module, but it also includes new capabilities such as:

• Sequential Drilling
• Deep Hole Drilling

• Back Countersinking

• Hole Chamfer Milling

• Hole Milling and Boss Milling

• Thread Milling and Boss Thread Milling

• Radial Groove Milling
Manufacturing caveats

General caveats

NX process

When you exit NX, it may close the UI without stopping the process. There is no data on how widespread this problem is.

Work Instructions

Do not include Documentation operations as the target for the following commands, as unexpected results may occur.

- Parallel Generate
- Replay
- Object Transform
- Simulate
- Gouge Check
- Verify

Shop Documentation

Each time you create Shop Documentation, NX generates facet bodies. To reduce the size of your part file, delete the facet bodies before saving it.

Command Finder: Faceting

Tilt Tool Axis

<table>
<thead>
<tr>
<th>Problem</th>
<th>Workaround</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shortest 2D distance to curve</td>
<td>Use the 3D shortest distance option.</td>
</tr>
<tr>
<td>For longer tool paths, the shortest distance calculation can become unsynchronized.</td>
<td></td>
</tr>
<tr>
<td>The tilted tool path may have non cutting moves with lifts in regions where they are not needed, and the moves can cause gouges.</td>
<td>None</td>
</tr>
</tbody>
</table>

IPW

- A Generic Motion (GMC) operation does not change the machine mode state of the IPW. Adding a Machine Control subop with a Set Modes event at the beginning of the GMC operation does not change the machine mode state of the IPW. The previous machine mode, either milling or turning, remains active.

  If the preceding operation does not have the required machine mode, you must add an operation with the required machine mode before the Generic Motion operation. For example, if the
Generic Motion operation is for turning, add a turning operation. The new operation must generate tool path, but does not need to cut material.

**Note**
This is not a limitation in ISV when you use the CSE driver. The machine state is defined by the workpiece spindle setting, which is either turning or milling.

- The IPW calculation is inconsistent:
  - For **Verify** and **Simulate**, rapid motions do not remove material.
  - When you generate the tool path for operations using the IPW, rapid motions can remove material.

This difference can result in unexpected results, for example when you use **Show 3D IPW**.
Milling caveats

Interpolate Vector tool axis option

The locations of the points are sensitive to drive method settings, and changes to cut direction, cut pattern, and cut area may relocate vectors defined earlier. Make sure you check the vectors after modifying the drive settings.

Area milling drive method operations using trim boundaries

The Contact tool position option for trim boundaries trims the tool path to the tool contact of the trim boundary. However, with the Extend at Edges cutting parameters option selected, the tool is moved past the contact by the specified extend distance. In the past trim boundaries were not changed by the Extend at Edges option.

[Area milling drive method operation]→Cutting Parameters→Strategy tab→Extend Path group

Curve/Point drive method — Offset Left option

The loops caused by offsetting a concave curve or curves are not trimmed.

Rotary Floor milling

<table>
<thead>
<tr>
<th>Problem</th>
<th>Workaround</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Min. Lead Angle does not influence the tool path.</td>
<td>None</td>
</tr>
<tr>
<td>When you use sheet geometry to define a concave floor, sometimes the default material side is wrong and no tool path is produced.</td>
<td>1. In the Rotary Floor Finish Drive Method dialog box, in the Drive Geometry group, click Flip Material. 2. Generate the operation.</td>
</tr>
<tr>
<td>The cutting parameters option Roll Tool Over Edges does not affect the tool path.</td>
<td>None. This parameter will be removed.</td>
</tr>
</tbody>
</table>

Fixed-axis contouring cut area selection

<table>
<thead>
<tr>
<th>Problem</th>
<th>Workaround</th>
</tr>
</thead>
<tbody>
<tr>
<td>Problem</td>
<td>Workaround</td>
</tr>
<tr>
<td>---------</td>
<td>------------</td>
</tr>
<tr>
<td>When you edit a cut area created with the selection method set to <strong>Edge Bounded Region</strong>, the seed face and the bounding edges display in the selection color and are difficult to identify.</td>
<td>You can use the alternate selection color to identify the seed face and bounding edges.</td>
</tr>
<tr>
<td></td>
<td>• To see the seed face, click <strong>Select Bounding Edges</strong>.</td>
</tr>
<tr>
<td></td>
<td>• To see the bounding edges, click <strong>Select Seed Face</strong>.</td>
</tr>
</tbody>
</table>

**Tip**

If you still cannot see the bounding edges, increase the line width display.

Menu → Preferences → Visualization → Visualization Preferences dialog box → Line tab → Part Settings group → Show Widths ✓ → set Width Scale to Maximum
### Contour Profile variable axis profiling

<table>
<thead>
<tr>
<th>Problem</th>
<th>Workaround</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Contour Profile</strong> operations only compensate for diminishing walls when the wall is in contact with the floor.</td>
<td>None</td>
</tr>
<tr>
<td>Supported cases:</td>
<td></td>
</tr>
<tr>
<td>Not supported cases:</td>
<td></td>
</tr>
<tr>
<td>Multiple offset passes that push the tool entirely above the wall height significantly increase generation time.</td>
<td>To reduce generation time, limit the number of offsets so that they do not exceed the wall height.</td>
</tr>
</tbody>
</table>
Hole machining caveats

Tapping operations

Drilling and Tapping are distinct operation subtypes. Although tapping cycles are available in the Drilling operation dialog box, we recommend that you do not use a Drilling operation combined with a tapping cycle. The tapping cycles will be removed from the Drilling operation in a future release.

In a Tapping operation, you can set feature geometry parameters, such as pitch, that output the required mom variables for tapping. If you use one of the tapping cycles in a Drilling operation:

• The operation will not contain the necessary feature geometry parameters and in-process feature volumes for tapping.

• You will have the legacy Point to Point output where the pitch is driven by feed rate.

Deep drilling limitation for partial intersections

When you drill through a cross hole, or partial intersection, NX now crosses the intersection in a single motion using the Step Over feed rate. Partial intersections are intersections that are smaller than the Cross Over distance specified in the Cutting Parameters dialog box, on the Strategy tab, regardless of the angle of the crossing hole.

All other intersections are considered full intersections. NX crosses full intersections in 3 motions using the First Cut, Cross Over, and Last Cut feed rates.

Back Counter Sinking operation

The Gouge Checking option reports false gouges.
ISV caveats

Visualize 2D Dynamic

- If blank geometry is not defined, you must click Step Forward twice before NX asks for blank geometry.

- On the Linux and Mac OS X platforms, the 2D Dynamic tab may not be active.
  The 8-bit PseudoColor visual graphics driver mode is not supported. As a work around, change the graphics X server settings. For example:
  NVidia Quadro and FX graphics drivers
  In the XF86Config file, in the Device section, set CIOverlay to TRUE.

Simulation

- In certain cases the reported minimum distance of a clearance violation is not the closest distance.

- Selecting a location on the tool path is now supported in ISV for both CSE-based simulation and tool path simulation. Selecting tool path segments involving cycles, such as drilling cycles, may not work in some cases.

  There are also some cases in which the selected positions of rapid motions are not displayed correctly.

- When the simulation runs in the history buffer, and the spindle speed Output Mode for an operation is set to SFM or SMM to maintain constant surface speed, the simulation behavior can be unreliable.

CSE simulation

- In the new Program Manager dialog box, you must start Machine Code Simulation before you can use the Check Syntax command.

- When there are multiple workpiece objects, the tool trace is always attached to the first component classified as _WORKPIECE, and moves with the component. If the tool trace is displayed on the wrong component, you can reorder the kinematics tree to place the required _WORKPIECE component first.

  The position of the tool trace is relative to the active tool, as that tool is defined in the CSE driver.

Virtual NC Kernel (VNCK)

- In the Machine Axis dialog box, on the Advanced tab, the WCS values are always the same as the MCS values.

- Displaying the CSE variables can influence performance. As a best practice, either limit the number of variables to approximately five, or use the controller panel of the Sinumerik controller to check the status of NC variables.

- Do not use the Fast Reset command; it can cause an internal error. As a workaround, use the Full Reset command.
• When it reaches a breakpoint, the simulation may fail to stop or may not stop at the exact position specified.

• When multiple working versions of VNCK with HMI Advanced are installed on a computer, you can only run one version at a time.

Positional ISV — Show Machine Axis Positions dialog box

• If you are running VNCK, the WCS is always the same as the MCS.

• When the setup has a multi-function machine and you use the dynamic manipulator to change the tool axis for a fixed-axis operation, NX does not update the Show Machine Axis Positions dialog box. To avoid confusion, use the Show Machine Axis Positions customer default to suppress the dialog box.


  2. In the Customer Defaults dialog box, choose Manufacturing→User Interface.

  3. Click the Dialog Boxes tab, and in the Visibility group, clear the Show Machine Axis Positions Dialog check box.

Program Manager

Adding or importing a program file without a file extension can cause problems. Make sure the files you import have a file extension.

Generate IPW with Path customer default

Using the Generate IPW with Path customer default may cause commands that require the IPW, such as Verify, to have problems when the IPW is not complete. This can happen because the IPW takes more time to generate than the operation.
**Post Configurator**

**DEF File Editor**

The editor removes comments from the main definition file, including any existing comments.

**Synchronization Manager**

You cannot reorder operations within *Synchronization Manager* for a post created by Post Configurator. You must order the operations in the *Program Order* view before entering *Synchronization Manager*.

**Heidenhain MillTurn support**

MillTurn operations are not postprocessed correctly for Heidenhain controllers when you create the postprocessor with Post Configurator.

Workaround: None.

**Canned Cycles**

The drilling depth output is wrong if the depth is deeper than 99 mm.

**Output of spindle orientation for back bore operation**

The spindle orientation might be wrong in some situations.

**UDE Rotate**

The postprocessor might crash in some cases when you add *UDE Rotate* to the operation.

**TCPM prepositioning plane**

When this option is activated, the plane output for the prepositioning is wrong in the following case:

- There is only one MCS in the *Geometry View* of the *Operation Navigator*, and
- The MCS is defined as *Local*, and
- *Special Output* is set to *None*. 
Feature based machining caveats

Teach Feature Mapping, Teach Operation Sets

Teach Operation Sets does not automatically copy the conditions for identical operations.

Limitations and workarounds:

<table>
<thead>
<tr>
<th>When you</th>
<th>Teach Operation Sets does not use</th>
<th>Workaround</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run Teamcenter Integration for NX, and store</td>
<td>The correct operation subtypes</td>
<td>• Manually add the missing tool classes and</td>
</tr>
<tr>
<td>the operation templates in Teamcenter</td>
<td></td>
<td>operation subtypes to the generated machining</td>
</tr>
<tr>
<td>Use a library other than the native ASCII</td>
<td>The tool class</td>
<td>• Replace the missing subtypes and classes.</td>
</tr>
<tr>
<td>library, such as MRL or TDM</td>
<td></td>
<td>To do this:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1. (Optional) Change your CAM configuration to</td>
</tr>
<tr>
<td></td>
<td></td>
<td>use native operation types and the standard</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ASCII tool library.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2. Use Teach Operation Sets to teach the</td>
</tr>
<tr>
<td></td>
<td></td>
<td>operations.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3. Use the Machining Knowledge Editor to add</td>
</tr>
<tr>
<td></td>
<td></td>
<td>or optionally replace the tool classes and the</td>
</tr>
<tr>
<td></td>
<td></td>
<td>operation subtypes.</td>
</tr>
</tbody>
</table>

NX 11.0.2 Manufacturing documentation additions and corrections

NX 11.0.2 Manufacturing documentation corrections

Correction — Using tracking points in drilling operations

A tracking point is the internal reference point on the tool that NX uses to output tool paths. NX also uses the tracking point specified as the drive point to calculate tool paths. The standard tools have system-defined tracking points. You can use the existing tracking points or define additional tracking points anywhere on the tool.
The **Tracking Data** option specifies the tracking point to use for all moves within the tool path. By default, NX sets the Tracking Data option to None, which outputs the entire tool path at the tool tip centerline.

For **Single Moves** motion output only, after you specify a **Tracking Data** point, you can specify an additional **Cycle Tracking** point for the composite of engage, retract, and cut motions defined by the drilling cycle. NX automatically changes between the **Tracking Data** point for positioning and traversal moves, and the **Cycle Tracking** point for the **Single Moves** drilling cycle. For example, the drilling operation could use the following system-defined tracking points:

- **SYS_CL_TIP** at the tool tip for all positioning and traversal moves.
- **SYS_CL_SHOULDER** at the tool shoulder for the moves within the drilling cycle.

If the cycle output contains engage and retract moves, such as those for break chip or for interrupted holes, the drilling operation would then use:

- **SYS_CL_TIP** for traversal, approach, and departure moves.
- **SYS_CL_SHOULDER** for engage, cutting, and retract moves within the drilling cycle.
Example outputs for different drilling cycle tracking points

1 SYS_CL_TIP output:
GOTO/-25.352,89.572,-24.403

2 SYS_CL_SHOULDER output:
GOTO/-25.352,89.572,-22.000

Using a tracking point to position the tool

To ensure that a position on the tool reaches a certain depth, select the tracking point that corresponds to that position and designate it as the Tool Drive Point. For example, you can select the shoulder of a drill, or a specific shoulder of a step drill.

Where do I find it?

<table>
<thead>
<tr>
<th>Application</th>
<th>Manufacturing</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>You must do the following in the drilling operation to specify which tracking points to output:</td>
</tr>
<tr>
<td></td>
<td>• Select a drilling tool with defined tracking points.</td>
</tr>
<tr>
<td></td>
<td>• Set the <strong>Motion Output</strong> option to <strong>Single Moves</strong>.</td>
</tr>
<tr>
<td></td>
<td>• Customize the drilling operation dialog box to include the <strong>Tracking Data</strong> and <strong>Cycle Tracking Data</strong> lists.</td>
</tr>
</tbody>
</table>
Set the tracking point for non cutting positioning moves:

[Drilling operation dialog box]→Tool group→Cutter Compensation subgroup→Tracking Data list

Set a tracking point for the drilling cycle:

[Drilling operation dialog box]→Path Settings group→Cycle Tracking Data list

Set a tracking point to position the tool:

[Drilling operation dialog box]→Geometry group→Specify Feature Geometry→Common Parameters group→Tool Drive Point list

Correction — Tool Path Report dialog box

The Gouges list displays a node for each tool path selected to gouge check. When NX finds gouges, the tool path nodes include a subnode for each sequence of consecutive gouging motions, and each subnode lists the individual motions.

Gouges

- ROUGH
  - Gouge-1

  GOTO/X212.460,Y30.162,Z-1.600
  CIRCLE/CX73.247,CY151.395,CZ-1.600,EX223.439,EY206.410,EZ-1.600
  CIRCLE/CX155.469,CY57.729,CZ-1.600,EX230.300,EY203.078,EZ-1.600
  GOTO/X245.300,Y195.356,Z-1.600

When NX does not find any gouges:

- The tool path node does not display any subnodes.
  
  Gouges

  - ROUGH

- Select Gouge displays (0), which indicates that nothing can be selected.

Edit variables in the Execution View dialog box

What is it?

In machine code simulation, in the Execution View dialog box, you can modify local NC, AnyController, and CSE variables temporarily, for debugging purposes.
Why should I use it?

It is easier to assign the value of a variable and check whether the rest of the program runs properly, rather than to correct the root cause and start over.

Where do I find it?

<table>
<thead>
<tr>
<th>Application</th>
<th>Manufacturing</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prerequisite</td>
<td>Run a machine code simulation. The machine must have a CCF file defined.</td>
</tr>
<tr>
<td>Location in dialog box</td>
<td>Simulation Settings group→Show Execution View→Variables group</td>
</tr>
</tbody>
</table>

Machine Code Simulate status enhancements (11.0.2)

What is it?

Several enhancements can help you to understand the status of a machine code based simulation.

![Show Execution View](image)

The Status group in the Simulation Control Panel dialog box is replaced by the new State Attributes group in the Execution View dialog box. In the State Attributes group:

- You can view information such as the feed rate, the current workplane, or the active interpolation.

- Use the Move Up and Move Down buttons to change the parameter order.

- You can export the State Attributes to a browser window or a spreadsheet.

**Note**

You define which State Attributes parameters to include in the .MCF file of the CSE driver.

The simulation time now displays in the Animation group of the Simulation Control Panel dialog box.
Show Machine Status

The Machine Axis Positions dialog box is renamed to Machine Status, and includes additional information. You can configure the Machine Status dialog box tabs to add and reorder columns.

The Standard tab is renamed to Axes, and now shows the following status symbols for rotary axes and spindles:

- **Stop** — The rotary is stopped.
- **Axis** — The rotary is in positioning mode.
- **Counterclockwise** — The rotary is spinning counterclockwise.
- **Clockwise** — The rotary is spinning clockwise.

The Advanced tab is renamed to Advanced Axes. You can display the Spindle Mode and Spindle Speed columns to show the status for a rotary axis or spindle.

The new Tools tab displays all currently mounted tools and includes the following tool attributes:

- **Current Tool Name**
- **Tool Type**
- **Active Correction** — Indicates if tool length correction is enabled.
- **Tool Length L, Tool Length Q, and Tool Length Z** — Display the tool length used for compensation.

For milling tools, only L is applicable. For turning tools, typically L is along X, Q is along Y, and Z is along Z.

The following example is for an OD turning tool.

<table>
<thead>
<tr>
<th>Tool Simulation setting</th>
<th>Machine Status value</th>
</tr>
</thead>
<tbody>
<tr>
<td>X Mount = 152.4</td>
<td>Tool Length L = 152.4</td>
</tr>
<tr>
<td>Y Mount = 20</td>
<td>Tool Length Q = -20</td>
</tr>
</tbody>
</table>

- **Tool Radius**
- **Next Tool**

Where do I find it?

<table>
<thead>
<tr>
<th>Application</th>
<th>Manufacturing</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prerequisite</td>
<td>Machine code based simulation</td>
</tr>
</tbody>
</table>
Machining time analysis

What is it?
Use machining time analysis to track total time, cutting time, and secondary time for your programs.

When the Detect Air Cutting Time check box is selected, cutting time is divided into the following:

- **Cutting Material**
  When the cutter is engaged in the IPW.

- **Cutting Air**
  When the tool is not removing material.

Secondary time is divided into the following:

- **Positioning**
  All positioning motions, such as rapid moves.

- **Dragging**
  The phase of a rapid move when the interpolator of a joint has reached the target value, but the real joint value has not yet reached the target, although it is closing the gap.

- **Delay**
  All times which are introduced through a delay() statement in AnyController code.

- **Wait**
  All times spent while stopping on WAIT commands for channel synchronization, and all times that do not fit in other categories.
Above, an analysis of the sim06 sample machine, with *Show 3D Material Removal* enabled.

**Where do I find it?**

<table>
<thead>
<tr>
<th>Application</th>
<th>Manufacturing</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prerequisite</td>
<td>Under simulation settings, select the <strong>Analyze Machining Time</strong> ✔ and <strong>Detect Air Cutting Time</strong> ✔ check boxes.</td>
</tr>
<tr>
<td>Location in dialog box</td>
<td>In the <strong>Simulation Control Panel</strong> dialog box, select the <strong>Show 3D Material Removal</strong> ✔ check box to detect material cutting.</td>
</tr>
<tr>
<td>Location in dialog box</td>
<td><strong>Machining Time Analysis</strong> group in the <strong>Execution View</strong> dialog box.</td>
</tr>
</tbody>
</table>
Chapter 7: Simcenter (CAE)
New Simcenter application names and product

The computer-aided engineering (CAE) capabilities of NX are now called Simcenter, the Advanced Simulation application is now called Pre/Post, and the Motion Simulation application is now called Motion. Several other features that were previously identified as NX or LMS features are now identified as Simcenter features. For example, NX Multiphysics is now called Simcenter Multiphysics, and the LMS Motion solver is now called the Simcenter Motion Solver.

In addition to encompassing the CAE functionality within NX, Simcenter is also a stand-alone product based on NX technology. It includes the following applications:

- Gateway
- Modeling
- Assemblies
- Pre/Post
- Motion
- Stress Wizard
- Vibration Wizard
- Durability Wizard
- Flexible Pipe
- PTS Author
- Block UI Styler
- PCB Exchange
- Visual Reporting
- Product Template Studio
- Requirements Validation
- Bookmarks
Simcenter supported platforms

For information about operating system platforms supported by Simcenter, see Operating system requirements.

Note
Simcenter does not support the Mac OS X.

Pre/Post

Caveats

Meshing

• The Auto Fix Failed Elements option in the 3D Tetrahedral Mesh dialog box does not work for tetrahedral meshes created with the Boundary Layer type in the Mesh Control dialog box.

• You cannot currently use the Element Attach command to attach elements to a target mesh if the elements interact with the boundary of that target mesh in such a way that the target mesh is split into two or more separate regions.

Load Recipe Manager

• Only Nodal Pressure, Displacement, Velocity, and Acceleration loads are supported for use with the new Aggregated boundary conditions option. Simcenter 11 does not support the use of Aggregated boundary conditions with Force loads.

• You cannot create XY plots of Aggregated boundary conditions.

Post Processing

• For NX Nastran laminate composite results, Simcenter Post-processing takes the in-plane and inter-laminar stresses together to calculate the ply-stress invariants. Consequently, the values reported by Simcenter Post-processing are different from the values found reported in the NX Nastran results file (.f06).

• You cannot use the Result Probe command to display results on models that contain super elements.

• The Layout State commands are supported only in FEM and Simulation files in Simcenter Pre/Post.

• When you use the Envelope command to create a results envelope and export that envelope to a universal (UNV) file, the software does not write information on solid laminate elements to the UNV file.

• With the Color Bar Plot, you can plot up to 200 functions. To change this maximum function limit, set the following environment variable: UGII_MAX_RECORD_COUNT_OF_COLORBAR.
Materials

In NX 7.5, the default material library changed from an NX-specific .dat format to a MatML XML format. Beginning with Simcenter 11, the legacy material library .dat format will no longer be supported.

Microsoft MPI installation required to load Abaqus ODB results files

Post-processing in Simcenter Pre/Post requires that you have an installation of the Microsoft MPI to load Abaqus ODB files. Beginning with Simcenter 11, Siemens PLM Software can no longer redistribute the Microsoft MPI with the Simcenter installation. To install the Microsoft MPI:

1. Find the latest version of the Microsoft MPI at the following link:

2. Download MSMpiSetup.exe.

3. Follow the steps in the installation wizard to install Microsoft MPI on your local system.

NX Nastran environment

For NX Nastran Vibro-Acoustics analyses, if your solution includes an Enforced Motion load on any structural dependent nodes, such as those from RBE2 elements, these DOFs will appear in both the SPC set (s-set) and the RBE dependent DOF set (m-set), causing the solver to abort. If your intent is to provide enforced structural motions as input to a weakly coupled vibro-acoustic solution, you can specify PARAM, SPCSTR, YES in the input file to avoid this error and instruct the solver not to compute the already provided structural vibrations.

Simcenter Multiphysics environment

If you create a load with the Distributed Force command and select the Component Vector Fields type, the software incorrectly exports the vector field information to the FORCDST and TLOAD3 bulk data entries. For each of the force and moment vectors on the TLOAD3 entry, all three components currently have the same table ID assigned (corresponding to the first component).

Abaqus environment

• You can define only the following types of constraints at the solution level in Simcenter 11:

  o Fixed Constraint (*BOUNDARY keyword)

  o Fixed Translation Constraint (*BOUNDARY keyword)

  o Fixed Rotation Constraint (*BOUNDARY keyword)

  o Initial Conditions (*INITIAL CONDITIONS, TYPE=VELOCITY)

If your input file contains any other type of constraints defined at the solution level, the software does not import them. It issues a warning message that indicates that the constraints were not imported.

• The software does not correctly import Abaqus assembly models (models defined with the *ASSEMBLY/*PART/*INSTANCE keywords) that contain DCOUP2D or DCOUP3D elements.
• If your input file contains equations that have more than four terms, the software does not import the equation.

• Pre/Post does not currently support the *KINEMATIC COUPLING keyword for import into the Coupled Thermal-Structural environment. The *KINEMATIC COUPLING command corresponds to the Automatic Coupling command in the Abaqus environment.

ANSYS environment

• The Default Cyclic Symmetry Cylindrical CSYS options in the New FEM and New FEM and Simulation dialog boxes are currently unsupported when you import ANSYS input files into the software and export ANSYS input files from the software.

• Although the software can export component pressures that are defined in all coordinate system types, it can import only component pressures that are defined in the Cartesian coordinate system.

• When you import an ANSYS input file that requires the software to create a new coordinate system, such as when you import the NROTAT command, the label for that new coordinate system may conflict with the label of an existing coordinate system.

• In the Advanced Solver Options and Export Simulation dialog boxes, if you select the Do not use block format option for nodes and elements check box, the software fails to write out the SECNUM command for SOLID272 and SOLID273 elements. To work around this issue, do not select this check box if your model includes SOLID272 or SOLID273 elements.

LS-DYNA environment

• The Default Cyclic Symmetry Cylindrical CSYS options in the New FEM and New FEM and Simulation dialog boxes are currently unsupported when you import LS-DYNA input files into the software and export LS-DYNA input files from the software.

• Material *MAT_116 (*MAT_COMPOSITE_LAYUP) is not supported for import.

• Material *MAT_054-055 (*MAT_ENHANCED_COMPOSITE_DAMAGE) is now supported for import and export. However, during import, Simcenter incorrectly maps *MAT_054-055 in the user interface to *MAT_COMPOSITE_LAYUP (the default).

• You can now define the stress-strain curve for LS-DYNA materials. Simcenter exports this data as the LS-DYNA keyword *MAT PIECEWISE_LINEAR_PLASTICITY or as *MAT_024. However:
  o Temperature-dependent stress-strain data is currently unsupported. Although you can define it in Simcenter, only the first temperature value is exported to your LS-DYNA input file.
  o The *MAT PIECEWISE_LINEAR_PLASTICITY keyword is not yet supported for import. It will be supported in a future release.

Samcef environment

• The following issues occur when you post-process Samcef results:
  o Relative rotation results are incorrect (zero values are shown).
o The material orientations are not displayed when post processing interlaminar stress tensors on cohesive elements.

o The results file associated with a Samcef solver is not Inferred but Specified.

• The following issues occur in the Solution Monitor:
  o In some cases, the Solution Monitor displays empty graphs.
  o On Linux operating systems, the Solution Monitor is refreshed every 10 seconds (instead of every second on Windows platforms). You must wait during the refreshing cycle to view the information on the new tab you selected.

• When Fibersim version 15.1 or lower is installed, Samcef fails to execute if the Solution Monitor is activated.

• The following issues occur when you import a Samcef model:
  o The software fails to import a Samcef .SEL group of elements that contains .MCE elements.
  o When importing Samcef Surface-To-Surface .MCT contact conditions:
    ■ Two equivalent Node-To-Surface Contact simulation objects are created instead of one Surface-To-Surface object.
    ■ The Samcef OPT coupled/uncoupled option is ignored.
  o The following issues occur when you import a Samcef Thermal model:
    ■ The import fails to retrieve the material orientation coordinate system for some elements.
    ■ The import fails to retrieve the Initial Temperature if the temperature varies both with time and space.

• The following issues occur when creating a model for a Thermal analysis:
  o In a Fluid Network Definition simulation object with a Conductive Mesh defined using a group, the use of the Ancillary Display invalidates the current object.

Acoustics BEM environment

• In a weakly coupled analysis, you must define displacements at all structural nodes. In this release, you cannot run an analysis with displacements defined at only a subset of the structural nodes.

• On Linux machines, the solver may not find boundary conditions at some frequencies. Simcenter Pre/Post writes the analysis frequencies in an ASCII file using 6 digits. The solver must retrieve boundary conditions at those frequencies from its binary database. The tolerance for this operation is lower on Linux machines (1.0E-06) than on Windows machines (1.0E-04). Because of the lower tolerance value on Linux, there is a fair probability that when the frequency is not an integer, the solver may not find any boundary condition within the tolerance. When this occurs, the solver either computes zero results or, in a weakly coupled analysis, issues a fatal error and exits.
To work around this issue, you can increase the tolerance by setting `ENVIRONMENT DBS_TOLERANCE = 1.0E-04` in the `SYSNOISE.STP` file that is located in the Simcenter 11 installation in the `SIMULATION/acoustics/sysnoise/res` directory.

**Simcenter Thermal/Flow, Space Systems Thermal, and Electronic Systems Cooling**

Surface tension is not supported in immiscible fluid mixtures.

**Durability**

Durability only uses table fields for S-N and E-N curves.

**Simcenter Laminate Composites**

Because sheared material properties for woven ply material are incorrectly computed, the following restrictions apply in this release:

- In the **Woven Ply Material** dialog box, you can no longer define a weft fiber angle. The software assumes it is always 90 degrees. Also you can no longer select the **Account for Woven Fiber Shear** check box.

- In the **Draping Data** dialog box, when you set **Solver** to **Woven**, the **Secondary Alignment** is forced to **Use default**. The software assumes the secondary direction is orthogonal to the primary direction.

**Motion**

**Caveats**

The following issues currently exist in Simcenter Motion.

**Simcenter Motion Solver**

- Virtual.Lab models with stiction ON may produce different results with the Simcenter Motion Solver.

- The displacement, velocity, and acceleration channels of a 3D contact element are not computed by the Simcenter Motion Solver. They are always reported as 0.

- For displacement, velocity, and acceleration of either a point-on-curve or curve-on-curve element, the Simcenter Motion Solver computes only the absolute values on X, Y, and Z. If you try to plot other results, an **error message appears**: The requested result is not supported with the Simcenter Motion Solver.

**Mechatronics co-simulation**

- The order of inputs and outputs in the Motion interface co-simulation block (as seen from LMS Imagine.Lab Amesim) does not follow the order of inputs and outputs as they are set in the **Mechatronics** dialog box within the Simcenter Motion application. Proper association between existing Amesim components and a newly imported Motion interface must be done by name.
• In the Mechatronics dialog box, if you modify the Scale or Offset value for an existing port, the software does not automatically recompute any existing solutions.

• The suppression status of output ports generated by a mechatronics interface is not propagated to the referencing control outputs and drivers.

• Due to certain file extension restrictions, you cannot use a motion simulation that includes a mechatronics interface or control input or output with Teamcenter Integration.

• When you create or edit a Mechatronics Control Output object, if you edit the origin and select a new point, the software may issue the following error message

    An error has occurred from a Selection filter callback. Please refer to syslog for more details.

To work around this issue, highlight the Specify Origin field before you try to edit the point.

Tires and roads

• You cannot currently select a road object in the graphics window. You must select the road object from the Motion Navigator.

• If you are using the FTire, you might encounter slightly different results when you solve the mechanism a second time, even if you have not made any changes to the Motion model. This occurs when the FTire solver fails to reset a particular variable during a static analysis. This issue should be fixed in the 2016-2 release of the FTire software. In the interim, you might be able to avoid this situation by repositioning or reconfiguring the road so that any variations in height occur later in the simulation (such as 20 cm further forward).

• The Simcenter Motion Solver supports 95 results variables. However, the new CDTire libraries export up to 180 results variables. Because of this, if you solve a mechanism when all of the check boxes are selected on the Selected Results Variables tab in the CDTire Property dialog box, the solution could fail. You can avoid this error by clearing the Energy Loss Due to Friction check box.

• Pressure data in the friction surface data file used by the Basic and Motorcycle tire elements is always considered in N/mm². Any pressure unit specified in the friction surface data file is ignored.

• Due to certain file extension restrictions, you cannot use a motion simulation that includes tire or road objects with Teamcenter Integration.

LMS Virtual.Lab to Simcenter Motion migration

• Joints defined with a principal axis of motion other than the Z-axis are not correctly imported from Virtual.Lab Motion into Simcenter Motion. You must correct the axis selection in the Simcenter Motion model.

• If the center of gravity (CG) for a Virtual.Lab Motion body is defined based on a CATPart axis system, then the CG information is not correctly imported into the Simcenter Motion model.

• Virtual.Lab bodies that reference CATProduct assemblies which include non-identity transformations between the assembled CATParts and the parent CATProduct are not imported correctly into Simcenter Motion.
Documentation notes

Solvers

The new NX Motion solver supports the same functionality as the Simcenter Motion Solver, with the exception of the following:

- Tires and roads
- Flexible links
- Co-simulation

When you see a reference to the Simcenter Motion Solver in the documentation, the same reference applies to the NX Motion Solver. With the exceptions listed above, if it is supported in the Simcenter Motion Solver, it is supported in the NX Motion Solver. Likewise, if it is not supported in the Simcenter Motion Solver, it is not supported in the NX Motion solver.

Note

The NX Motion solver is available only in NX. It is not available in Simcenter.
Chapter 8: Design Simulation
Caveats

Report Writer

Design Simulation does not support report generation through application-provided sample templates and commands. Fully user-defined report customizations are supported.
Chapter 9: Inspection and validation

Check-Mate and Requirements Validation

Caveats

Validation rules

Validation rules do not yet recognize unset part attributes.

Using Teamcenter as the issue site for NX Issue Management

When you use NX Issue Management, you can specify Teamcenter as the issue site only when Teamcenter Issue Manager is deployed via Teamcenter Environment Manager at the server side. NX displays an error message if it cannot connect to Teamcenter Issue Manager. For more information, refer to the Teamcenter Environment Manager Help.

CMM Inspection Programming

CMM release notes

PAX file change

The .pax files are now located in the UGII_BASE_DIR\cmm_inspection\templates folder.

VALISYS critical maintenance and retirement notice

The VALISYS application is unsupported as of July 21, 2016. Use the NX CMM Inspection Programming application instead of VALISYS Programming and use CMM Inspection Execution instead of NX-Inspect.

Linking to PMI information

All geometry referenced by PMI must be in the current reference set, and if it is not, then NX:

- Issues warning messages in the information window.
- May still create features, but will not create paths because there is no access to the feature geometry.
Caveats

Renaming or deleting the SENSORS group

In the Inspection Navigator, do not delete or rename the SENSORS group as this may cause machine simulations within the Inspection Path dialog box to fail.

Machine simulation

When you create an inspection path or simulate a program, you may see the following INI Programs message:

In order to handle INI files in the Program Manager, define the channels in the Machine Tool Builder.

You can ignore this message for NX CMM Inspection applications. It has no effect on the machine simulation.
Chapter 10: Tooling Design

Weld Assistant

Documentation notes

Weld Point Wizard

When you create weld points using the Weld Point Wizard, when you set Method to Existing Point, clear the Automatic Update check box to ensure that the newly created linked faces are deleted.
Chapter 11: Data translation
Product Notes

Updates in the default tessUG.config JT configuration file

The doSectionViews configuration option which is used to process non-lightweight PMI section views (also known as heavyweight section views) is removed from the default tessUG.config file shipped with NX11. This option is now renamed as LegacyHeavyweightSectionViews. If your existing NX part or assembly contains section views created using PMI tab→Section View command in Pre-NX11 versions and you want to translate these section views to a JT file, you need to add LegacyHeavyweightSectionViews option in your tessUG.config configuration file and set it to true.

CATIA V5 translator product notes
You can now import CATIA V5-6R2016 files to NX.

ACIS translator product notes
NX11.0.1 can now read and write ACIS version up to R26.

DXF/DWG translator product notes
You can now read and write AutoCAD DXF/DWG version up to 2017.

NX to JT translator product notes
NX to JT translator now supports the IRAY texture material translation to JT file.
Caveats

Internationalization caveat

File import or export by the following translators may not work if you set the NX temporary directory `UGII_TMP_DIR` to a folder containing non-locale characters.

- DXF/DWG
- IGES
- STEP
- 2D Exchange (export only)

**NX to JT translator caveats**

NX to JT translator caveat for the Windows operating system

NX to JT translator does not support new IRAY+ materials, textures, and lights defined on objects in an NX part. When translator encounters such parts during processing, it writes the base color of the object in the JT file and adds a warning message in the log file.

If you are translating pre-NX11 parts with material, texture, and light applied on it and you want to get the texture or light information into the JT file, We recommend you to invoke NX in Author2 (non-IRAY+) rendering mode and then translate the parts to a JT file. This recommendation is applicable for JT creation from interactive NX session as well as command line application `ugtopv`. Contact GTAC to get more information on how to invoke NX in Author2 (non-IRAY+) rendering mode.

JT configuration option `advancedMaterials` in the JT configuration file is not applicable for the new IRAY+ materials, texture, and lights.

By default, NX 11 uses new IRAY+ renderer and the Material, Light and Texture option is not available in the JT Configuration and the Export JT dialog boxes.

**Note**

If you invoke NX in Author2 (non-IRAY+) rendering mode then these options will be available in the JT Configuration and the Export JT dialog boxes.

NX to JT translator caveat for the Linux operating system

During JT creation on Linux operating system, you may experience issues like freeze of translation process for some parts. This is not a generic issue and only occurs with specific part files. If you encounter any such issue with your part files, please contact GTAC and log an IR.

NX to JT - IRAY texture and material caveats

In some situation, you may find some difference in the quality of the texture displayed in NX and in JT when viewed in the Teamcenter Visualization.
DXF/DWG translator caveats

DXF/DWG — Dimension export caveats
These caveats are applicable when you export a file using the 3D option in the AutoCAD DXF/DWG Export Wizard dialog box.

- Dimensions associated with external references are exported as non-associative dimensions to the DXF/DWG file.
- NX Radius dimensions associated with ellipse or spline object are translated as AutoCAD block reference.
- The dimension associated between NX sheet object and View port object may be translated as overridden text of AutoCAD dimension.
- Narrow dimensions are exported as non-associative dimensions to the DXF/DWG file.
- Chamfer and Thickness dimensions are exported as block reference to the DXF/DWG file.
- Angular dimensions created with vector option are exported as block reference to the DXF/DWG file.
- Dimension with fits tolerance having fit tolerance style other than Fit Symbol is exported as block reference in AutoCAD.
- Dimension text location may not match with NX for the dimensions created with oriented text.
- Dimension line breaks and foreshortening symbols are not supported when dimension is exported as group or block.
- If a dimension text is on the extended dimension line, the exported dimension has to be updated to view any foreshortening symbols on it.

DXF/DWG — MText import caveats
You cannot import:

- MText paragraph tabs to NX.
- Euro symbol (created using %%128 in MText) to NX.

DXF/DWG — Architecture data import caveats
You can not import:

- View dependent data
- Texture data
- Corner windows
- Wall cleanups
- Body modifiers on staircase
• Associativity defined between the architecture objects is not maintained in NX. For example, door on wall will not move along if wall is moved.

DXF/DWG — Solids import caveats
You cannot import:
• Material, color, and transparency applied on solids in the DXF/DWG file.
• Solids data at location outside the NX supported bounding box.

DXF/DWG translator- Image translation Caveats
• When you import DXF/DWG model data to NX drawing view, the translator does not support image translation.
• When you import DXF/DWG file that contains image rotated by angle which is not in a multiple of 90, the image is imported with zero degree rotation.

Note
In NX, the images are rotated in steps of 90 degrees only.

• When you import DXF/DWG file with images having other than .jpeg, .tiff, and .png formats to NX, the translator does not support importing of such images.
• Images are not imported if exported as CGM.
• Image translation is not supported if the DXF/DWG file is imported to workpart.

DXF/DWG translator- 3D Workflow caveats
When you export View Breaks using 3D workflow, the translator does not support an export of the following:
• NX Object clipping and view break symbols.
• Geometry clipped inside a view boundary.
• A section line arrow in Break view.

Dimension export using 3D workflow
• When a dimension is exported as a block reference, the foreshortening symbol is not supported.
• 3D workflow does not support the inclusion of before/after appended text in the export of the inspection dimension. It always includes all the appended text in the frame.
• The translator does not support a tolerance separator in the output DXF/DWG file.

Text export using 3D workflow
• When you export text as lines using 3D workflow, the translator ignores the text symbol aspect ratio.
2D Exchange caveats

- Object attributes with title longer than 50 characters or string value longer than 132 characters are not exported to 2D parts.

2D Exchange – Dimension export caveats

These caveats are applicable for both, when you export a file using the **NX Part file** option in the **2D Exchange Options** dialog box or when you export a file using the **2D** option in the **AutoCAD DXF/DWG Export Wizard** dialog box.

Following dimensions are exported with the Override Dimension Text:

- Feature Parameter Dimensions
- True Length Dimensions
- Dimensions in scaled view and output set to **Modeling** (applies only when you export a file using the **NX Part file** option in the **2D Exchange Options** dialog box)

- Dimensions associated to:
  - Drafting Intersection point
  - Offset center point
  - Section line (in scaled view)

- The dimensions where associated object type changes in the flattened part. For example, circle projected as line.

Following Data will be exported as grouped geometry in the 2D part file and as a block in the DXF or DWG file.

- Linear and Radial callouts
- Retained dimensions
- Component level dimensions and PMI dimensions
- Inherited ordinate PMI dimensions
- Dual dimension in scaled views and output set to **Modeling**.
- Dimension with hole and shaft tolerance in scaled views and output set to **Modeling**.

- Dimensions associated with:
  - Blanked objects
  - 3D and Symmetric centerlines
  - Faces
  - Two object intersection (applies to ordinate dimension only)
Target Points

- Dimension created in plane other than view plane.

2D Exchange translator - Image translation caveats
- 2D Exchange Translator does not translate image, if image is not projected on 2D. This happens when image is in XY plane and trimetric view is exported.
- 2D Exchange Translator supports translation of images only if input is being exported to Part File and not to IGES).

2D Exchange translator - Dimension export caveats
- When Dimension and a Leader are associated with the symmetrical centerline, the translator exports them as a grouped geometry.
- When a radial dimension is associated with a break view geometry, the translator exports it as a group geometry.
- When a perpendicular and angular dimension is associated with a break view section line, translator exports them as a group geometry.

2D Exchange translator - Foreshortening Symbol export caveats
A translator does not support export of foreshortening symbol when dimension is exported as a group in a 2D part.

2D Exchange translator – Leader caveats
A leader with an extension line is converted as a grouped geometry when it is associated with a spline in a 2D part.

2D Exchange translator – Weld symbol caveats
When you export a weld symbol containing arcs, the translator exports it as a grouped geometry.

STEP translator caveats
- When you export or save NX data to a .stpx file, STEP translator does not export nested external references.

CATIA V5 translator caveats
- When you use the NX Data Exchange external interface to export an assembly on Linux 64 or Mac operating system, the output file field may indicate an extension of .CATPart, whereas the translator will accurately produce an output file with the expected .CATProduct extension.
- The translator exports NX files to CATIAV5 R14 files.
- You cannot import CATIA V5 R7 and earlier version of files.
- You cannot translate standard and user defined attributes.
- Color is supported on a per face basis.
• You can only import CATIA V5 “Lines and Curves” into NX using default “Linetype” and “Thickness” values.

• You cannot export NX parts with file name containing international characters.
Chapter 12: 4th Generation Design
Product Notes

4G Easy

Beginning with the Teamcenter 11.2.2 release, the \texttt{4gd_populate_utility} is replaced by the \texttt{4g_easy} utility. You can use the new \texttt{4G Easy} tool to interact with the utility. See the Teamcenter \textit{4th Generation Design} help for more information.
Chapter 13: Mechatronics Concept Designer
Product Notes

PLCOpen XML export for STEP 7

Mechatronics Concept Designer can export the sequence of operation in the standardized XML format PLCOpen XML. PLCOpen XML can be imported into STEP 7 5.5 SP 2 Hotfix 4 and above. If you need to update your current STEP 7 installation you can find information about the latest service packs and hotfixes at the following:

English:
https://support.industry.siemens.com/cs/products?dtp=Download&mfn=ps&pnid=14342&lc=en-WW
Chapter 14: Line Designer
Product notes

Template files
The standard part files delivered with Line Designer must be imported into the Teamcenter database to ensure that they are available in the New Item dialog box. If this step is not performed, the New Item dialog box displays only blank templates.

A setup script for installing Line Designer templates in Teamcenter is included with NX:
%UGII_ROOT_DIR%\LINE_DESIGNER\templates\tcin_linedesigner_template_setup.bat

For information about how to use the script, see Installing File New templates in the NX help at the following location:

Home→
Teamcenter Integration for NX→
System Setup/Administration→
Server Setup/Administration→
Installing/creating/modifying templates→
Installing File New templates

Platform support
Line Designer is currently supported only on Windows platform.

Data Upgrade
Due to changes in the connector features in NX 11, equipment that uses connectors created in pre-NX 11 releases must be upgraded to the new NX 11 format. To do this, we recommend that you open and save the equipment in releases NX 11 or above.

Alternatively, you can also use the refile_part utility to upgrade the data in batch mode. For more details, see Refiling in the NX help.

For more information, see Using library components with connectors from pre-NX 11 releases in the Line Designer caveats.

4GD support
Use of Line Designer with 4GD capabilities requires a Teamcenter Plant extension for fourth generation. Migrating from the FactoryCAD to the Line Designer library also requires a Teamcenter Plant extension. This extension is included in the Manufacturing Additions package to Teamcenter installation (ManufacturingAdditions 1.4). You can get the Manufacturing for 4GD package from the download section of the Siemens PLM Software download server.

From the left side list of the product categories, choose Teamcenter and Teamcenter Rapid Start.

The Windows package is located at:

Teamcenter and Teamcenter Rapid Start→
Full Products→
Integrations and Solutions→
ManufacturingAdditions→
1.4→
Teamcenter10 / Teamcenter11→
The Linux package is located at:

Teamcenter and Teamcenter Rapid Start →
  Full Products →
    Integrations and Solutions →
      ManufacturingAdditions →
        1.4 →
          Teamcenter10 / Teamcenter11 →

TC10.x_ManufacturingAdditions_1.4_wntx64.zip /
TC11.x_ManufacturingAdditions_1.4_wntx64.zip

Instructions for applying the Manufacturing Plant extensions are included in the package zip file (Plant Extensions - Deployment Guide.pdf).

Factory resource samples

Installation of the sample factory resources, conveyors, and robots from the manufacturing resource sample library to Teamcenter is highly recommended.

  Factory Resources
  Factory Conveyors
  Factory Robots

Instructions for installing the samples are located in the following section of the Teamcenter HTML documentation:

  Home →
    Installing →
      Installation on Windows Servers Guide →
        Adding Features →
          Manufacturing →
            Installing and configuring the Manufacturing Resource Library

Manufacturing Resource Library version compatibility

Line Designer in the NX release 11.0.2 is certified for use with factory resources from the Manufacturing Resource Library (MRL) 3.1.7 or later for Teamcenter release 10.1.7 or TC11.2.3.

You should always upgrade the Manufacturing Resource Library components from previous release to the new release.

Upgrading smart objects to the current NX version

NX will automatically upgrade the older version of smart objects from previous NX releases to the new version when they are opened and saved in new version of NX.
Documentation notes

Note the following about the Line Designer documentation:

- Although Line Designer can work with either BVR or 4GD data structures, typically the documentation describes the 4GD procedures.
Caveats

Editing smart component sketches

While you edit sketches of smart components, the 3D object is visible. You can still edit the sketch values by dragging the sketch nodes.

Configured components in the Plant Navigator

Configured components from the plant structure appear as loaded components in the Plant Navigator.

Using library components with connectors from pre-NX 11 releases

While placing or disconnecting components within a layout, or while dragging components to another layout, you may experience incorrect behavior if any components have connectors created in a pre-NX 11 release.

Recommendation

Before using the library objects in NX 11.0 Line Designer layouts, you should upgrade the library object’s part files which include connectors created in pre-NX 11 releases.

You can upgrade the library objects by opening and saving them in Line Designer NX 11.0 or use the refile_part utility to upgrade the data in batch mode.

Replacing Smart and PTS components

In a layout, after replacing existing connected smart and PTS components with new components, you may find incorrect Number and Part Description for both the components. You may find this behavior when you create and save components in NX 11.0.2.

Workaround

Open the Replace Component dialog box and select the Components to Replace and Replacement Part and click OK.

In the Template Explorer dialog box, in the Settings group, click Rename Options.

In the Part Management dialog box, in the Part Names group, click Reference check box, click OK and close the Template Explorer dialog box.

Show Occurrence Name

In a layout, when working with components migrated from a release prior to NX 11.0.2, the Occurrence Name column doesn’t show value for the components.
Workaround

Open the layout in NX, remove the **Occurrence Name** column using **Column Configuration**, and close NX.

Restart NX, open the layout again and add the **Occurrence Name** column.

**Note**

You need to perform the above workaround only once for the components with an **Occurrence Name** issue.
Chapter 15: Programming Tools

The Release Notes for Programming Tools are available only with the installed NX Help documentation. After you install the documentation, you can access the information from any of the following locations.

• From the Start menu on your system, choose:
  o All Programs→Siemens NX 11.0→Documentation→NX Release Notes.
  o All Programs→Siemens NX 11.0→Release Information→NX Release Notes.

• Within NX, choose:
  o File tab→Help→Release Notes.
  o Menu→Help→Release Notes.
Siemens Industry Software

Headquarters
Granite Park One
5800 Granite Parkway
Suite 600
Plano, TX 75024
USA
+1 972 987 3000

Americas
Granite Park One
5800 Granite Parkway
Suite 600
Plano, TX 75024
USA
+1 314 264 8499

Europe
Stephenson House
Sir William Siemens Square
Frimley, Camberley
Surrey, GU16 8QD
+44 (0) 1276 413200

Asia-Pacific
Suites 4301-4302, 43/F
AIA Kowloon Tower, Landmark East
100 How Ming Street
Kwun Tong, Kowloon
Hong Kong
+852 2230 3308

About Siemens PLM Software

Siemens PLM Software, a business unit of the Siemens Industry Automation Division, is a leading global provider of product lifecycle management (PLM) software and services with 7 million licensed seats and 71,000 customers worldwide. Headquartered in Plano, Texas, Siemens PLM Software works collaboratively with companies to deliver open solutions that help them turn more ideas into successful products. For more information on Siemens PLM Software products and services, visit www.siemens.com/plm.

© 2017 Siemens Product Lifecycle Management Software Inc. Siemens and the Siemens logo are registered trademarks of Siemens AG. D-Cubed, Femap, Geolus, GO PLM, I-deas, Insight, JT, NX, Parasolid, Solid Edge, Teamcenter, Tecnomatix and Velocity Series are trademarks or registered trademarks of Siemens Product Lifecycle Management Software Inc. or its subsidiaries in the United States and in other countries. All other trademarks, registered trademarks or service marks belong to their respective holders.